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The Use of Symbols
The following manual includes several symbols to make it easier to follow the instructions.


The information symbol indicates an additional information on the action of the programme 
or on the handling with the programme.

NOTICE
The NOTICE indicates an important information. Disregarding may cause the programme to 
not run properly.


The arrow indicates a prerequisite for the following action. If this prerequisite is not given, 
the programme may can not follow with the given instructions.

 The check mark indicates the result of an action.



This symbol indicates an entry in the glossary. The symbol is placed after the corresponding 
word within the text.

General Information

NOTICE

Modifications on the software, that are going beyond the scope that is presented in 
this document, are not permitted!
Any consequences, that are referable to these modifications, will not be covered by 
the company.



About this Manual

1 About this Manual
This manual provides an overview of the programme bundle MultiAnalyzer. The manual describes the 
structure of the different programmes and shows the proper use of the programmes.

This manual is addressed to users with or without profound knowledge in radio technology or radio-
telephony. As a result of this, in some places this manual contains further information about radio 
technology and radio-telephony to make it easier to adjust the settings for ones purposes.

More detailed definitions of some terms are available in the glossary.

The manual follows a logical order for a gradual induction. Before start working with the programme 
bundle, read this manual carefully.

Follow the instructions precisely.
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Requirements

2 Requirements

PC Requirements

PC Hardware (Minimum)
Intel® Core™ i3(gen 10), 4GB Memory, 20 GB sufficient free space on 

hard-drive.

OS Windows 10 (64 bit, version 1809 or later)

USB-Ports 2.0 (used for chip set device connections)

Ethernet 10/100/1000 Mbit/s (used for measurement device connection)

Supported Recording Devices

• TCCA TMW
• RTL2832
• R&S EM 100
• R&S PR100
• R&S ESMD
• AirSpy
• MS2710xA
• SKY-i7000
• rfe-global (7504, 7510)
• Ettus UHD (N210, B210)
• Tektronix RSA 306

Supported Hardware Decryption Devices

• MASDecryptor

Further information on the requirements and additional specifications are described in another document.
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About the MultiAnalyzer Programme Bundle

3 About the MultiAnalyzer Programme Bundle
The MultiAnalyzer is a programme bundle for recording, storing, analysing, and watching protocol data.
The bundle includes the following components:

• MultiAnalyzerLicence
This programme is used to check the current licence options and to request a licence, which is 
needed by the other programme parts.

• MultiAnalyzerLicenceServer
This programme is used to maintain and distribute the pool of carrier licences.

• MultiAnalyzerLicenceClient
This programme is used to update the carrier licences that are provided by 
MultiAnalyzerLicenceServer.

• MultiAnalyzer
This GUI programme is used to start/stop records and to store the protocol data.

• MultiAnalyzerRecord
This command line programme is used to record and to store the protocol data.

• MultiAnalyzerProto
This programme is used to load stored protocol data, to analyse it, and to output the information in 
a human readable format (text file).

• MultiAnalyzerMsc
This programme is used to graphically present the analysed data in the form of message sequence 
charts with full access to all protocol elements.

• MultiAnalyzerQoS
This programme is used to graphically present the analysed data in the form of diagrams and 
statistics.

• MultiAnalyzerQosServer
This programme is used to stream recorded and analysed QoS data to the MultiAnalyzerQoS viewer.

• MultiAnalyzerSplitter
The separation programme is used to split recordings into parts or to cut out certain points in time. 
Additional the reverse joining is possible.

• MultiAnalyzerSaveRules
This programme is used to restrict saving options (e. g. allow only save encrypted).

• MultiAnalyzerNetworkViewer
This programme is used to visualise the data of radio towers and the connection between the radio 
towers.
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Getting Started

4 Getting Started
The MultiAnalyzer, MultiAnalyzerQoS, MultiAnalyzerQosServer, MultiAnalyzerRecord, 
MultiAnalyzerProto, MultiAnalyzerMsc and MultiAnalyzerNetworkViewer need a valid licence.

The licence is provided as a hardware dongle or as a licence file. The licence can be managed with the 
programme MultiAnalyzerLicence (see chapter 4.1     Requesting the Licence File  ) and with the programme 
bundle CarrierManager (see chapter 4.3     CarrierManager  ).

The MultiAnalzyerLicence is used to read and view the current licence (dongle or licence file) or to request 
the licence file “MultiAnalyzer.lic”. The CarrierManager includes the MultiAnalzyerLicenceServer and the 
MultiAnalzyerLicenceClient that are used to maintain and distribute the pool of carrier licences and to 
update these licences.

If a dongle is available, plug the dongle into the computer and ensure that the red LED of the dongle is 
switched on. If no light is on, check the dongle driver installation.

If a “MultiAnalyzer.lic” licence file was provided by the femvenner GmbH, copy the file into the programme 
folder (see Chapter 4.1     Requesting the Licence File  , step 6.).

If no licence file was provided by the femvenner GmbH, follow the next chapter to request a licence using 
the programme MultiAnalyzerLicence.
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Getting Started

4.1 Requesting the Licence File

If no licence is present, then it is necessary to request a licence file using the programme 
MultiAnalyzerLicence.

To request a licence file with MultiAnalyzerLicence, follow the next steps.

➔ MultiAnalyzerLicence is running.

1. Choose the network adapter from the tab page ‘Licence file’ (see 1).

Illustration 1 MultiAnalyzer Licence: Choosing Network Adapter



The licence is bound to a network adapter. If the network adapter is an onboard-hardware, the 
licence is fixed to this hardware. If a removable hardware is used (e. g. USB WiFi Adapter), the 
licence can be used more dynamical. This removable hardware has to be plugged into the 
computer all the time while the programmes are running.
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Getting Started

2. Click on the button [Create licence request…] (see 2).

Illustration 2 MultiAnalyzerLicence: Button Create Licence 
Request

✔ A form opens (see 3).

Illustration 3 MultiAnalyzerLicence: Request Licence File Form

3. To create a licence request, fill in the information and click on the button [Create licence request] 
(see 4).

Illustration 4 MultiAnalyzerLicence: 
Button Create Licence Request Form
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Getting Started

✔ The save dialogue opens to set the storage path of the request file (see 5).

Illustration 5 MultiAnalyzerLicence: Save Dialogue

4. To save the request file, choose the storage path and click on the button [Save].

 This is not the licence file itself it is just a request for a file.

5. Send the saved request file to the femvenner GmbH (malicense@femvenner.de).

 The femvenner GmbH generates the licence file and sends back the licence file.

© 2022 femvenner GmbH 7/247
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Getting Started

6. Copy the received licence file “MultiAnalyzer.lic” into the programme folder (see 6).

Illustration 6 MultiAnalyzerLicence: Copy File

✔ The programmes are ready to use.

 To view the licence options, see chapter 4.2     Licence Options  .
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Getting Started

4.2 Licence Options

If a licence file or dongle is present, the licence data can be viewed in the MultiAnalyzerLicence.

The following information can be checked in the displayed window:

• Bound network card or dongle ID and update level

• User information

• Enabled options

• The time-out date (if the licence is time restricted)

• Enabled driver

Illustration 7 MultiAnalyzerLicence: Licence File Info
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Getting Started

Illustration 8 MultiAnalyzerLicence: Dongle Info
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Getting Started

4.3 CarrierManager

The CarrierManager is a programme bundle for administration of the carrier licenses. The bundle includes 
two components:

• MultiAnalyzerLicenceServer
This programme is used to move carrier licenses from the pool to the client dongles and vice versa. 
It needs the master dongle to start the programme.

• MultiAnalyzerLicenceClient
This programme is used to show and update the information of the client dongles. The programme 
is also used to write the carrier licences, which are generated by the master dongle to the client 
dongles. The programme can only manage the client dongles.
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Getting Started

4.3.1 MultiAnalyzerLicenceServer

The MultiAnalyzerLicenceServer maintains and distributes the pool of carrier licences.

This chapter provides an overview of the MultiAnalyzerLicenceServer interface and menus.

1a

2a

3a

4a

Illustration 9 MultiAnalyzerLicenceServer: Interface

No Description

1a List of all owned client dongles.

2a Information about the master dongle.

3a Information about a selected client dongle.

4a Buttons to load and save update files.
Table 1 MultiAnalyzerLicenceServer: Interface
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Getting Started

Master Dongle Information in Detail:

 None of these information can be changed.

5a 6a

7a

8a

9a

10a

11a12a
Illustration 10 MultiAnalyzerLicenceServer: Master Dongle Information Detail

No Description

5a ID of the connected master dongle.

6a Name of the connected master dongle.

7a Number of all owned carrier licences.

8a Number of all available owned carrier licences, which can be handed out.

9a Number of all owned temporary carrier licences.

10a Number of all available owned temporary carrier licences, which can be handed out.

11a Number of full licences (programme licence and carrier licence).

12a
Number of available full licences (programme licence and carrier licence), which can be 
handed out.

Table 2 MultiAnalyzerLicenceServer: Master Dongle Information Detail
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Getting Started

Client Dongle Information in Detail:

13a

14a

15a

16a

17a18a19a20a

Illustration 11 MultiAnalyzerLicenceServer: Client Dongle Information Detail

No Description

13a ID of the client dongle.

14a Name of the client dongle.

15a Number of carrier licenses on the selected client dongle.

16a Number of temporary carrier licenses on the selected client dongle.

17a Status of the selected client dongle (OK, Broken, Destroyed, Lost, Stolen).

18a
Number of temporary carrier licenses which the selected client dongle gets with an 
update.

19a Checkbox to indicate whether a full licence is or is not activated on that dongle.

20a Number of carrier licenses which the selected client dongle gets with an update.
Table 3 MultiAnalyzerLicenceServer: Client Dongle Information Detail
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Menu ‘File’

Illustration 12 MultiAnalyzerLicenceServer: Menu 
‘File’

Name Key Combination Description

Open File... Ctrl+O Open the update file.

Save Update File... Ctrl+S Save the update file.

Force Dongle Update and Save File... none

Force the MultiAnalyzerLicenceClient to 
write the dongle data into the selected 
dongle.

 Use only if the normal update 
does not work.

Quit Ctrl+Q Quit the programme.
Table 4 MultiAnalyzerLicenceServer: Menu ‘File’

Menu ‘View’

Illustration 13 MultiAnalyzerLicenceServer: 
Menu ‘View’

Name Description

About Qt... Show information about the used tool set.

About MultiAnalyzerLicenceServer...
Show information about the 
MultiAnalyzerLicenceServer themselves.

Table 5 MultiAnalyzerLicenceServer: Menu ‘View’
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Getting Started

4.3.2 MultiAnalyzerLicenceClient

The MultiAnalzyerLicenceClient is used to update the carrier licences that are provided by 
MultiAnalyzerLicenceServer.

This chapter provides an overview of the MultiAnalyzerLicenceClient interface and menus.

Illustration 14 MultiAnalyzerLicenceClient: Interface

No Description

1b List of all connected client dongles.

2b Section with the information about the selected dongle.

3b Buttons to load and save update files.
Table 6 MultiAnalyzerLicenceClient: Interface
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Dongle Information in Detail:

4b

5b

6b

7b

8b

Illustration 15 MultiAnalyzerLicenceClient: Dongle Information Detail

No Description

4b ID of the selected dongle.

5b Name of the selected dongle.

6b Number of carrier licences of the selected dongle.

7b Number of temporary carrier licences of the selected dongle.

8b Checkbox to indicate whether a full licence is or is not activated on this dongle.
Table 7 MultiAnalyzerLicenceClient: Dongle Information Detail
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Menu ‘File’

Illustration 16 
MultiAnalyzerLicenceClient: 
Menu ‘File’

Name Key Combination Description

Open File... Ctrl+O Open the update file.

Save... Ctrl+S Save the update file.

Quit Ctrl+Q Quit the programme.
Table 8 MultiAnalyzerLicenceClient: Menu ‘File’

Menu ‘View’

Illustration 17 MultiAnalyzerLicenceClient: 
Menu ‘View’

Name Description

About Qt... Show information about the used tool set.

About MultiAnalyzerLicenceClient...
Show information about the MultiAnalyzerLicenceClient 
themselves.

Table 9 MultiAnalyzerLicenceClient: Menu ‘View’
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4.3.3 Transferring the Carrier Licences to a Client Dongle

The licences that are provided on a master dongle can be transferred to or removed from the client 
dongle.

To change the carrier licence of a client dongle, follow the next steps.

➔ MultiAnalyzerLicenceServer is running.

➔ A master dongle is present and connected to the PC.

➔ A client dongle is present and connected to the PC.

NOTICE

Programme works only with the master dongle!

The programme can only be started if the master dongle is connected. Ensure that the 
right dongle is connected to the PC.

1. Allocate the carrier licences to the client dongle in the software (see 18).

 In this example 2 carrier licences are moved from the pool to the dongle of number 1000.

Illustration 18 MultiAnalzyerLicenceServer: Allocate Carrier
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2. To generate the update file for the carrier licence, click on the button [Save Update…] (see 19).

Illustration 19 MultiAnalyzerLicenceServer: Save Update File

✔ The update file is generated.

✔ The save dialogue opens to save the update file (see 20).

Illustration 20 MultiAnalyzerLicenceServer: File To Save

3. To save the update file, choose the storage path and click on the button [Save].
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✔ The colour of the currently used client dongle is changed (see 21).

Illustration 21 MultiAnalyzerLicenceServer: Colour Change

4. Open the programme MultiAnalyzerLicenceClient.

5. To open the update file for the carrier licence, that was saved in Step 3., click on the button [Open 
File…] (see 22).

Illustration 22 MultiAnalyzerLicenceClient: Open File
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✔ A selection dialogue opens to select the update file (see 23).

Illustration 23 MultiAnalyzerLicenceClient: Select Update File

6. To open the update file, choose the file and click on the button [Open].
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Getting Started

✔ A dialogue opens to inform about the update status (see 24).

Illustration 24 MultiAnalyzerLicenceClient: Update Status

7. Click on the button [OK].

✔ A dialogue opens to inform about the next steps (see 25).

Illustration 25 MultiAnalyzerLicenceClient: Dongle Update Response

8. Click on the button [OK].
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✔ A save dialogue opens to save the response file (see 26).

Illustration 26 MultiAnalyzerLicenceClient: File To Save

9. To save the response file, choose the storage path and click on the button [Save].
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Getting Started

✔ The dialogue indicates that the dongle owns 2 carrier (see 27).

Illustration 27 MultiAnalyzerLicenceClient: Floating-Carrier

10. Re-open the programme MultiAnalyzerLicenceServer.
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Getting Started

11. To open the response file, that was saved in Step 9., click on the button [Open Update…] (see 28).

Illustration 28 MultiAnalyzerLicenceServer: 
Open Update File

✔ A selection dialogue opens to select the response file (see 29).

Illustration 29 MultiAnalyzerLicenceServer: Select Response File

12. To open the response file, choose the file and click on the button [Open].
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Getting Started

✔ If the response file is loaded, the programme shows (in this example) that the dongle 1000 owns 2 
carrier licenses and 8 carrier licenses are still available (see 30).

Illustration 30 MultiAnalyzerLicenceServer: Licences Changed

✔ The carrier licences are transferred to the client dongle.

 To view the licence options of the dongle, see chapter 4.2     Licence Options  .
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Record and View Protocol Data

5 Record and View Protocol Data
Three components are used to record and watch protocol data.

The GUI programme MultiAnalyzer (see chapter 5.1     MultiAnalyzer  ) or the command line programme 
MultiAnalyzerRecord (see chapter 5.3     MultiAnaylzerRecord  ) are used to record and store protocol data.

The programmes can handle different drivers for recording devices. These devices can be different receiving 
hardware or virtual devices e. g. network TMW recording. The recorded data is processed according to the 
device and protocol type (physical layer, forward error correction, converted). The programmes save the 
recorded data as not analysed raw data.

The MultiAnalyzerProto is used to load the raw data and to analyse the protocol. The MultiAnalyzerProto 
filters redundant data and stores the important data as a human readable text file.

The MultiAnalyzerMsc (see chapter 5.6     MultiAnalyzerMsc  ) is used to load the text file (*.txt) or the record 
file. The data are prepared in the MultiAnalyzerMsc to graphically present the data in a message sequence 
chart.

Any recorded and stored raw file can be reloaded with the MultiAnalyzerProto at a later date.

 To present the record file as diagrams, charts or lists, the file can be loaded into the 
MultiAnalyzerQoS (see chapter 5.7     MultiAnalyzerQoS  ).
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Record and View Protocol Data

5.1 MultiAnalyzer

The MultiAnalyzer is the GUI programme to start/stop records and to save the protocol data.

This chapter provides an overview of the different sections, the settings and the menus of the 
MultiAnalyzer.

1c 3c

2c

4c

Illustration 31 MultiAnalyzer: Interface

No Description

1c List with all used drivers and devices.

2c List with all unused drivers and devices (sorted by location, driver and device).

3c
Section with different pages that provide configuration information, record settings, and 
SDR settings.

4c The Scanner Application (see chapter 5.2     Scanner Application  )
Table 10 MultiAnalyzer: Interface
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The section 3c includes, depending on the selected SDR, the current record state (idle or recording), and 
the SDR-driver type, the following tab pages:

Info
Provides the SDR configuration information and the recording status (see chapter 
5.1.1     Record Settings – Info  ).

Record
Provides the record settings like record type, frequency, and start/stop recording 
(see chapter 5.1.2     Record Settings – Record  ).

SDR Settings
Provides special SDR settings like gain level or frequency adjustment (see chapter 
5.1.3     Record Settings – SDR Settings  ).

Channel Info
Provides options to set the gain level during a record, the view of the recorded 
channel spectrum, and the possibilities to graphically present the current record in 
other programmes (see chapter 5.2.3     Record Settings – Channel Info  ).

Scanner Will be available in a future version to provide an overview of the frequency 
spectrum.

Table 11 MultiAnalyzer: Record Settings
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Menu ‘File’

Illustration 32 
MultiAnalyzer: Menu 
‘File’

Name Key Combination Description

Quit Ctrl+Q Quit the programme.
Table 12 MultiAnalyzer: Menu ‘File’

Menu ‘Devices’

Illustration 33 MultiAnalyzer: Menu 
‘Devices’

Name Key Combination Description

Add Driver… Ctrl+D Add a device or protocol driver DLL.

Scan for Local Devices Ctrl+S
Rescan for new hardware devices that are connected 
to the PC.

Table 13 MultiAnalyzer: Menu ‘Devices’
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Menu ‘Windows’

Illustration 34 MultiAnalyzer: Menu 
‘Windows’

Name Description

Recording Devices
Show or hide the window with the recording devices. The window 
contains all used drivers and devices.

Device List
Show or hide the window with the different devices. The window 
contains all unused drivers and devices.

Record Settings

Show or hide the window with the record settings. This section contains 
the tab pages to start or stop recording, change settings, and monitor 
physical recording.
For more information see chapters:

• 5.1.1     Record Settings – Info  

• 5.1.2     Record Settings – Record  

• 5.1.3     Record Settings – SDR Settings  

• 5.2.3     Record Settings – Channel Info  

Scanner Application
Find and identify carrier within a spectrum (see chapter 5.2     Scanner   
Application).

Table 14 MultiAnaylzer: Menu ‘Windows’

 TETRA AIE options are described in another document.
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Menu ‘View’

Illustration 35 MultiAnalyzer: Menu 
‘View’

Name Key Combination Description

Save Windows none

Save the current window positions.

 At the next start this window positions 
are reused.

Restore Windows none Reuse formerly stored window positions.

Language none Change the interface language.

Open User Guide Ctrl+H Open the user manual.

About Qt... none Show information about the used tool set.

About MultiAnalyzer... none
Show information about the MultiAnalyzer 
themselves.

Table 15 MultiAnalyzer: Menu ‘View’
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5.1.1 Record Settings – Info

Depending on the recording state and the SDR type, the tab page ‘Info’ shows different sets of data. 

The following table provides an overview of these different data:

Idle SDR (IQ) Recording SDR (IQ)

Illustration 36 MultiAnalyzer: Record Settings 
‘Info’ Idle SDR (IQ)

Illustration 37 MultiAnalyzer: Record Settings ‘Info’  
Recording SDR (IQ)

Idle SDR (TMW) Recording SDR (TMW)

Illustration 38 MultiAnalyzer: Record Settings ‘Info’ 
Idle SDR (TMW)

Illustration 39 MultiAnalyzer: Record Settings ‘Info’  
Recording SDR (TMW)
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Name Description

Device Type Connection type:
• USB: External device connected by USB
• STD: Logical device

Name Name of the device.

Serial Number Serial number of the device.

Info Information about the producer.

DLL Magic Internal number of the driver DLL.

Device Number Number of the device in the driver DLL.

Device Options Kinds of data that can be recorded:
• IQ data (record from air interface)
• TETRA TMW (record from UDP interface: TCCA TTR 005-01)

Frequency Range Record range of the IQ SDR frequency spectrum.

Record Type
Channel

Recording IQ data which are analysed as channel, like TETRA, 
etc.

TETRA TMW Recording virtual TMW data.

TETRA-DL/UL The recording channel is of the type TETRA.

SDR gain Gain level of the SDR (numeral or AUTO for device-controlled).

Frequency shift Correction value for frequency calculation of the SDR.

Auto freq. shift Auto correction of SDR centre frequency, determined by average frequency error.
Table 16 MultiAnalyzer: Record Settings ‘Info’ SDR (IQ and TMW)

Extra Functions-Buttons

Illustration 40 MultiAnalyzer: Record Settings ‘Info’ Get device info

As long from TCP/IP based device supported, the button “Get device info from <IP>” will viewed. Using the 
button causes a connection to the IP address and the device hardware-data is requested.

Table 17 MultiAnalyzer: Record Settings ‘Info’ Extra Functions Buttons
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5.1.2 Record Settings – Record

Depending on the recording state and SDR type, the tab page ‘Record’ shows different sets of data.

The following table provides an overview of these different data:

Idle SDR Recording SDR

1d

2d

3d

4d

5d

6d

7d

8d

9d

10d

11d12d

Illustration 41 MultiAnalyzer: Record Settings ‘Record’ (Idle 
SDR)

14d

13d

15d16d17d18d

Illustration 42 MultiAnalyzer: Record Settings ‘Record’ 
(Recording SDR)

No Description No Description

1d
Drop-down list to select the standard for 
recording (TETRA, DMR, TETRA-DMO).

13d
Downlink block error rate history from the 
last 5 minutes.

2d
Drop-down list to select the frequency band 
of the downlink carrier.

14d
Button to stop recording.

3d
Text field to choose the downlink channel 
number (0-3999).

15d
Button to open the explorer on the storage 
path level of the record file.

4d
Drop-down list to select the downlink 
channel frequency offset.
The bandwidth of one channel is 25kHz.

16d
Button to start the MultiAnalyzerQosServer 
to stream QoS-data.
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Idle SDR Recording SDR

For DMR use the Channel offset of 12,5kHz 
to align channel.
(TETRA channel 0 with Channel offset of 
0kHz = DMR channel 0
TETRA channel 0 with Channel offset of 
12,5kHz= DMR channel 1
TETRA channel 1 with Channel offset of 
0kHz = DMR channel 2)

5d Text field to directly set the frequency in Hz. 17d Button to start the MultiAnalyzerQoS.

6d
Checkbox to enable uplink recording.

18d
Button to start the MultiAnalyzerMsc and to 
show the data as message sequence charts.

7d
Text field to set the duplex frequency in Hz 
(usually 10Mhz).

8d
Drop-down list to select the second SDR for 
uplink.

9d
Drop-down list to select the auto name 
format.

10d
Drop-down list to select a record file auto 
splitting option.

11d
Text field to set the storage path of the 
record file.

12d Button to start the record.
Table 18 MultiAnalyzer: Record Settings ‘Record’ (Idle and Recording)

© 2022 femvenner GmbH 37/247



Record and View Protocol Data

Idle SDR (TMW) Recording SDR (TMW)

24d

19d

20d

21d

22d

23d

Illustration 43 MultiAnalyzer: IP Data (Idle SDR)

27d

26d

28d29d

25d

30d

Illustration 44 MultiAnalyzer: IP Data (Recording SDR)

No Description No Description

19d
Text field to set the receiving UDP port for 
TMW data.

25d
Number of received message (0-144) history 
of the last 5 minutes.

20d
Drop-down list to select the standard for 
recording (TETRA, DMR, TETRA-DMO).

26d
Button to stop the record.

21d
Drop-down list to select the auto name 
format.

27d
Button to open the explorer on the storage 
path level of the record file.

22d
Drop-down list to select a record file auto 
splitting option.

28d
Button to start the MultiAnalyzerQosServer 
to stream QoS-data.

23d
Text field to set the storage path of the 
record file.

29d
Button to start the MultiAnalyzerQoS.

24d
Button to start the record.

30d
Button to start the MultiAnalyzerMsc and to 
show the data as message sequence charts.

Table 19 MultiAnalyzer: IP Data (Idle and Recording)
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5.1.3 Record Settings – SDR Settings

The SDR settings page provides SDR specific settings. These settings are also valid for starting a scan via 
the Scanner Application (see chapter 5.2.1     Starting a Scan  ).

This chapter provides an overview of the SDR settings.

31d

32d

33d

34d

35d

Illustration 45 MultiAnalyzer: Record Settings ‘SDR settings’

No Description

31d
Text field to set the gain level of the SDR.

 For a RTL-SDR the value is in tenth. For example, 20,6 is 206.

32d Slider to set the gain level of the SDR.

33d

Text field to correct a systemic frequency offset of the SDR.

 SDRs that are not adjusted in frequency, may have a systemic frequency offset. 
The given value in Hz is used to correct this offset.

34d
Text field to set the static downlink uplink IQ data offset (see chapter The Static Downlink 
and Uplink Data Offset).

35d Slider to set the shift frequency between ‘On’, ‘Off’ and ’500000’.

Table 20 MultiAnalyzer: Record Settings ‘SDR settings’
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The Static Downlink and Uplink Data Offset

Downlink and uplink are synchronised transmitted at the air interface. If two different kinds of devices are 
used for downlink and uplink measurements, the IQ data streams are asynchronously delivered from the 
devices to the PC. So, the IQ data stream of device A has a static offset to device B (see 46):

Internal processing
time

TCP/IP transmission
time USB transmission

time

USB

LAN

Receiving
time

IQ data send
over TCP/IP

Illustration 46 Downlink Uplink Data Offset

This offset is caused by the internal receiving process of the IQ data and the delivery time at the 
transmission path. The software requires the static offset to be able to synchronise the uplink and the 
downlink. The offset value is set in the downlink SDR. The uplink value has no effect.

Values for known configurations are shown in the following table:

Configuration
No

Downlink Uplink

USB RTL2832U USB RTL2832U 0

R&S EM100 USB RTL2832U 0

USB RTL2832U R&S EM100 0

AirSpy R&S EM100 0

R&S EM100 AirSpy 0

AirSpy USB RTL2832U 0

USB RTL2832U AirSpy 0
Table 21 Static Offset Values

© 2022 femvenner GmbH 40/247



Record and View Protocol Data

5.2 Scanner Application

The Scanner Application scans the frequency spectrum, displays the spectrum and identifies carrier of 
supported standards, like TETRA and DMR.

Depending on whether the scanner application is idle or scanning, the programme shows different 
information.

This chapter provides an overview of the different Scanner Application interfaces.

Scanner Application (Idle)

5c

6c

7c 8c

9c

10c

11c

12c

13c14c15c

Illustration 47 MultiAnalyzer: Scanner Application Interface (Idle)
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No Description

5c Button to start/stop the scanner.

6c Buttons to shift the currently used centre frequency by +/- 0.5, 1 or 5Mhz.

7c
Input window to show and change the currently scanned centre frequency.

 The centre frequency can be changed while scanning.

8c
Drop-Down list to set the spectrum bandwidth around the centre frequency (1, 5, 10MHz).

 The bandwidth can be changed while scanning.

9c
Slider to change the gain level of the recording device.

 The gain level can be changed while scanning.

10c
Text field to change the gain level of the recording device.

 The gain level can be changed while scanning.

11c Area to graphically show the found carriers.

12c Area to show important broadcast data when a carrier is selected.

13c Area that lists the found carrier.

14c
There are two modes for viewing carrier. The current status and all identified.
With ‘Hold Found Carrier’ all found carrier maintains in the list. This is useful to identify sporadic 
transmitting carrier.

15c
Button to refresh the list.

 All carriers will be rescanned.

Table 22 MultiAnalyzer: Scanner Application Interface (IDLE)
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Scanner Application (Scanning)

12c

16c

17c

18c

13c19c

Illustration 48 MultiAnalyzer: Scanner Application Interface (Scanning)

No Description

12c Important broadcast data of a selected carrier.

13c

List of the identified carrier.
The view is sorted in ascending order:

1. Country
2. Network
3. Channel number

The position of the selected carrier is shown in spectrum display (blue vertical line) and the carrier 
data is printed in the broadcast view (12c).
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No Description

16c
A blue vertical line that marks the carrier frequency under the mouse pointer.
At the top of the blue line, the carrier frequency and an identified channel is displayed.

17c
Noise is grey-coloured, scan candidates are blue-coloured, identified channels are marked in other 
colours, depending on the standard (e. g. TETRA is green-coloured).

18c

The horizontal red and blue lines mark the scanning thresholds.
The red line represents the auto detected noise level.
The blue line represents the resulting threshold at which point the carriers will be identified (13dB 
above the detected noise level).
To be a candidate for channel identification, the peaks have to be above the blue threshold and 
need to have a known bandwidth. For example, 25kHz for TETRA or 12.5kHz for DMR.

19c
Button to stop scanning when a carrier is selected. The button opens the tab page ‘Record’ to start 
a record (see chapter 5.1.2     Record Settings – Record  ).

Table 23 MultiAnalyzer: Scanner Application Interface (Scanning)
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5.2.1 Starting a Scan

To find and read out a carrier and its information, a scan with the MultiAnalyzer can be started.

 The settings that are described in chapter 5.1.3     Record Settings – SDR Settings   are also valid for 
the scanner application.

To start a scanning process with the MultiAnalyzer, follow the next steps.

➔ Recording devices are available in the ‘Device List’.

1. Choose the scanning device from the ‘Device List’ (see 49).

Illustration 49 MultiAnalyzer: Choose a Device (Scanner)

2. To set the centre frequency, use the input window (see 50).

Illustration 50 MultiAnalyzer: Set Centre Frequency (Scanner)

 The centre frequency can also be changed by using the buttons that are located on the left and 
the right side of the input window.
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3. To set the gain of the recording device, use the slider or the text field (see 51).

Illustration 51 MultiAnalyzer: Set Gain (Scanner)

4. To set the bandwidth, use the drop-down list (see 52).

Illustration 52 MultiAnalyzer: Set Bandwidth 
(Scanner)

5. To start the scanner, click on the button [Start scanner] (see 53).

Illustration 53 MultiAnalyzer: Start 
Scanner (Scanner)
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✔ The scanner application starts scanning (see 54).

Illustration 54 MultiAnalyzer: Scan (Scanner)

 To record the data of a found carrier, see chapter 5.2.2     Starting a Record  .

© 2022 femvenner GmbH 47/247



Record and View Protocol Data

5.2.2 Starting a Record

Once a found carrier is chosen, the carrier and its information can be recorded and stored in a file.

To start a channel record of a found carrier, follow the next steps.

➔ A scan with the Scanner Application is running (see chapter 5.2.1     Starting a Scan  ).

1. Choose the wanted carrier from the list (see 55).

Illustration 55 MultiAnalyzer: Choose Carrier (Record)
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2. To stop the scanner, click on the button [Stop scanner] (see 56).

Illustration 56 MultiAnalyzer: Stop Scanner (Record)

✔ The chosen carrier is highlighted (see 57).

Illustration 57 MultiAnalyzer: Carrier Highlighted (Record)

3. Open the tab page ‘Record’ within the ‘Record Settings’ (see 58).

Illustration 58 MultiAnalyzer: Open Tab Page
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4. To start the record, set the settings and the storage path and click on the button [Start Record] (see 
59).

Illustration 59 MultiAnalyzer: Start Record (Record)



The tab page ‘Record’ also opens by clicking on the following button below within the Scanner 
Application during a scan 
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✔ The MultiAnalyzer starts recording (see 60).

Illustration 60 MultiAnalyzer: Recording (Record)

 For information about analysing the record file, see chapter 5     Record and View Protocol Data   
and 5.4     Analyse an Earlier Recorded File  .
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5.2.3 Record Settings – Channel Info

This chapter provides an overview of the different settings of the tab page ‘Channel Info’.

Depending on the direction (downlink/uplink), the tab page ‘Channel Info’ has different options available.

 This page is only available if a record with a SDR is running.

36d

37d

38d

39d

40d

41d

42d43d44d45d46d

Illustration 61 MultiAnalyzer: Record Settings ‘Channel Info’ 
(UL)

47d

Illustration 62 MultiAnalyzer: Record Settings ‘Channel Info’ 
(DL)

No Description No Description

36d

Text field to set the gain level of the SDR.

 For a RTL-SDR the value is in tenth. 
For example, 20,6 is 206.

47d

Downlink block error rate history from the 
last 5 minutes.

37d Slider to set the gain level of the SDR.

38d
Button to set the chosen gain level into 
action.

39d Visualisation of the record channel spectrum. 
A mouse click inside changes the type of 
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view.

40d Button to reset the level holding.

41d Button to stop recording.

42d
Button to open the explorer on the storage 
path level of the record file.

43d
Button to start the MultiAnalyzerQosServer 
to stream QoS-data.

44d Button to start the MultiAnalyzerQoS.

45d
Button to start the MultiAnalyzerMsc and to 
show the data as message sequence charts.

46d

Checkbox to hold the level if an uplink burst 
was detected, even if the uplink is not 
received any more.

 Noise has no influence on that 
level hold.

Table 24 MultiAnalyzer: Record Settings ‘Channel Info’ (UL and DL)
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5.3 MultiAnaylzerRecord

Another possibility to record is to use the DOS application MultiAnalyzerRecord.

 For the usage with batch files use the argument “-batch” to suppress all interactive actions.

To show a list of all available SDR devices, start the MultiAnalyzerRecord without any arguments:

• MultiAnalyzerRecord.exe

To get an overview of all available start arguments, start the MultiAnalyzerRecord with the following 
arguments:

• MultiAnalyzerRecord.exe -h

• MultiAnalyzerRecord.exe /h

The following chapters provide an overview of the command line arguments to record with 
MultiAnalyzerRecord.
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5.3.1 Record Real-Time TMW Data

To start a real-time TMW data record, use the following command line arguments:

MultiAnalyzerRecord.exe -TMWIP=<IPAddress> -TMWP=<PortNumber> 

-F=<”<ExistingPath>\MyRecordFile.maf”>

Required Arguments

-TMWP= Receiving port number.

-F= Path and file name of the record file. Add the file extension “.maf”.

Optional Arguments

-TMWIP= Local Ethernet interface for receiving UDP data, “0.0.0.0” for all interfaces.

-PROT=
Desired protocol for demodulation (TETRA or DMR).
If this option is not given, then TETRA is demodulated.

Table 25 MultiAnalyzerRecord: Recording TMW Data Arguments

Example

MultiAnalyzerRecord.exe -TMWIP=0.0.0.0 -TMWP=9999 -F=”C:\MyRecordFile.maf”

➢ TMW data is received at all local Ethernet interfaces at port 9999 and stored within the file C:\
MyRecordFile.maf.
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5.3.2 Record Real-Time with a SDR

To start a SDR air interface real-time record, use the following command line arguments:

MultiAnalyzerRecord.exe -DLF=<Frequency> -F=<”<ExistingPath>\MyRecordFile.maf”> -DLG=<Gain> 
-DLFS=<FrequencyShift> -DLSD=<x,y> -ULF=<Frequency> -ULG=<Gain> -ULFS=<FrequencyShift> -
ULSD=<x,y>

Required Arguments

Only Downlink

-DLF= “Downlink Frequency” in Hz.

-F= Path and file name of the record file. Add the file extension “.maf”.

Downlink and Uplink

-ULF= “Uplink Frequency” in Hz.

Optional Arguments

Only Downlink

-DLG= “Downlink SDR Gain” in tenth (12,6dB=126; 20,5dB=205; 30dB=300).

-DLFS=
“Downlink Frequency Shift” in Hz to adjust SDR systemic frequency discrepancy. 
400MHz is set via -DLF= but if the carrier is received at 400MHz+17500Hz, the –DLFS 
value has to be set to -17500.

-DLSD=
“Downlink Select SDR Device” to select a specific SDR device for the Downlink.
The necessary parameters are “x=DLL magic" and “y=Device number”. These values can 
be obtained via the “SDR device list” option (see chapter 5.3     MultiAnaylzerRecord  ).

Downlink and Uplink

-ULG= “Uplink SDR Gain” in tenth (12,6dB=126; 20,5dB=205; 30dB=300).

-ULFS=
“Uplink Frequency Shift” in Hz to adjust SDR systemic frequency discrepancy.
400MHz is set via -ULF= but if the carrier is received at 400MHz-12100Hz, the –ULFS 
value has to be set to 12100.

-ULSD=
“Uplink Select SDR Device” to select a specific SDR device for the uplink.
The necessary parameters are “x=DLL magic" and “y=Device number”. These values can 
be obtained via the “SDR device list” option (see chapter 5.3     MultiAnaylzerRecord  ).

Other Options

-PROT=
Desired protocol for demodulation (TETRA or DMR).
If this option is not given, then TETRA is demodulated.

Table 26 MultiAnalyzerRecord: Recording with SDR Arguments
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Examples

Downlink, minimum arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf”

➢ This receives a downlink channel at the frequency 391837500Hz (300MHz+Channel 3673+12,5kHz) 
with SDR gain of 0dB and a systemic SDR frequency shift of 0Hz.

Downlink, recommended arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -DLG=280 -DLFS=-17500

➢ This receives a downlink channel at the frequency 391837500Hz (300MHz+Channel 3673+12,5kHz) 
with SDR gain of 28,0dB and a systemic SDR frequency shift of -17500Hz.

Downlink and Uplink, minimum arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -ULF=381837500

➢ This receives a downlink channel at the frequency 391837500Hz (300MHz+Channel 3673+12,5kHz) 
with SDR gain of 0dB and a systemic SDR frequency shift of 0Hz. It also receives an uplink channel 
at the frequency 381837500Hz (300MHz+Channel 3273+12,5kHz) with SDR gain of 0dB and a 
systemic SDR frequency shift of 0Hz.

Downlink and Uplink, recommended arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -DLG=280 -DLFS=-17500 -
ULF=381837500 -ULG=210 -ULFS=12100

➢ This receives a downlink channel at the frequency 391837500Hz (300MHz+Channel 3673+12,5kHz) 
with SDR gain of 28,0dB and a systemic SDR frequency shift of -17500Hz. It also receives an uplink 
channel at the frequency 381837500Hz (300MHz+Channel 3273+12,5kHz) with SDR gain of 21,0dB 
and a systemic SDR frequency shift of 12100Hz.
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5.3.3 Record Real-Time with a Network Recording Device (NRD)

Network Recording Devices are supported devices, which send IQ-data via network.

Supported devices are:

• R&S EM100

• R&S ESMD

• Anritsu MS2710xA

To start a real-time record with a NRD, use the following command line arguments:

MultiAnalyzerRecord.exe -DLF=<Frequency> -F=<”<ExistingPath>\MyRecordFile.maf”> -DLG=<Gain> 
-DLFS=<FrequencyShift> -DLSD=<x,y> -DLIP=<IPAddress> -DLRP=<PortNumber> -NDSO=<SlotOffset> 
-DLNDT=<DeviceType> -ULF=<Frequency> -ULG=<Gain> -ULFS=<FrequencyShift> -ULSD=<x,y> -
ULIP=<IPAddress> -ULRP=<PortNumber> -ULNDT=<DeviceType>

Required Arguments

Only Downlink

-DLF= “Downlink Frequency” in Hz.

-F= Path and file name of the record file. Add the file extension “.maf”.

-DLIP Downlink network recording device IP address.

-DLRP Port number of the network recording device.

-DLNDT

“Downlink Network Device Type”
• „EM100“ for R&S EM100
• „ESMD“ for R&S ESMD
• „MS2710xA“ for Anritsu MS 2710xA

Downlink and Uplink

-ULF= “Uplink Frequency” in Hz.

Optional Arguments

Only Downlink

-DLG= “Downlink SDR Gain” in tenth (12,6dB=126; 20,5dB=205; 30dB=300).

-DLFS=
“Downlink Frequency Shift” in Hz to adjust the systemic frequency discrepancy.
400MHz is set via -DLF= but if the carrier is received at 400MHz+17500Hz, the –DLFS 
value has to be set to -17500.

-DLSD=
“Downlink Select SDR Device” to select a specific SDR device for the downlink. The 
necessary parameters are “x=DLL magic" and “y=Device number”. These values can be 
obtained via the “SDR device list” option (see chapter 5.3     MultiAnaylzerRecord  ).
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-NDSO=
“Network Device Slot Offset” that compensates the processing and delivering delay 
from the network device (e. g. 14500 for 14.5 slots offset (can be +/-)).
Only one offset has to be given even when two network devices are used.

Downlink and Uplink

-ULG= “Uplink SDR Gain” in tenth (12,6dB = 126; 20,5dB = 205; 30dB = 300).

-ULFS=
“Uplink Frequency Shift” in Hz to adjust the systemic frequency discrepancy.
400MHz is set via -ULF= but if the carrier is received at 400MHz-12100Hz, the –ULFS 
value has to be set to 12100.

-ULSD=
“Uplink Select SDR Device” to select a specific SDR device for the Uplink.
The necessary parameters are “x=DLL magic" and “y=Device number”. These values can 
be obtained via the “SDR device list” option (see chapter 5.3     MultiAnaylzerRecord  ).

-ULIP Uplink network recording device IP address.

-ULRP Port number of the network recording device.

-ULNDT “Uplink Network Device Type”

Other Options

-PROT=
Desired protocol for demodulation (TETRA or DMR).
If this option is not given, then TETRA is demodulated.

Table 27 MultiAnalyzerRecord: Recording with NRD Arguments

Examples

Downlink, minimum arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -DLIP=10.0.128.114 -
DLRP=9001 -DLNDT=MS2710xA

➢ This receives a downlink channel at the frequency 391837500Hz (300MHz+Channel 3673+12,5kHz) 
with SDR gain of 0dB and a systemic SDR frequency shift of 0Hz. 
The used network device is an Anritsu MS2710xA with the IP address 10.0.128.114 and the receiving 
port 9001.

Downlink, recommended arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -DLIP=10.0.128.114 -
DLRP=9001 -DLNDT=MS2710xA -DLG=-200 -DLFS=345

➢ Same channel as with Downlink, minimum arguments with the addition that the gain is set to -20.0 
dB and frequency is shifted by 345Hz
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Downlink (NRD) and Uplink (USB SDR), minimum arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -DLIP=10.0.128.114 -
DLRP=9001 -DLNDT=MS2710xA -DLF=381837500

➢ This receives a downlink channel at the frequency 391837500Hz (300MHz+Channel 3673+12,5kHz) 
with SDR gain of 0dB and a systemic SDR frequency shift of 0Hz. It also receives an uplink channel 
at the frequency 381837500Hz (300MHz+Channel 3273+12,5kHz) with SDR gain of 0dB and a 
systemic SDR frequency shift of 0Hz.
The used network device for the downlink channel is an Anritsu MS2710xA with the IP address 
10.0.128.114 and the receiving port 9001. For the uplink a RTL-SDR chip based SDR is used.

Downlink (NRD) and Uplink (USB SDR), recommended arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -DLIP=10.0.128.114 -
DLRP=9001 -DLNDT=MS2710xA -DLF=381837500 -DLG=-200 -DLFS=345-ULG=380 -ULFS=-17100 -
NDSO=-14500

➢ Same configuration as with Downlink (NRD) and Uplink (USB SDR), minimum arguments with the 
addition that the gain is set to -20.0 dB and frequency is shifted by 345Hz for Downlink. And for 
Uplink the gain is set to 38.0 dB and frequency is shifted by -17100Hz.
Network delay compensation (-NDSO) is set to -14.5 slots.

Downlink (USB SDR) and Uplink (NRD), minimum arguments:

MultiAnalyzerRecord.exe -ULF=391837500 -F=”C:\MyRecordFile.maf” -ULIP=10.0.128.114 -
ULRP=9001 -ULNDT=MS2710xA -ULF=381837500

➢ Same configuration as with Downlink (NRD) and Uplink (USB SDR), minimum arguments just the 
uplink and downlink devices are switched.

Downlink (USB SDR) and Uplink (NDR), recommended arguments:

MultiAnalyzerRecord.exe -ULF=391837500 -F=”C:\MyRecordFile.maf” -ULIP=10.0.128.114 -
ULRP=9001 -ULNDT=MS2710xA -ULF=381837500 -ULG=-200 -ULFS=345 -DLF=380 -DLFS=-17100 -
NDSO-14500

➢ Same configuration as with Downlink (NRD) and Uplink (USB SDR), recommended arguments just 
the uplink and downlink devices are switched.
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Downlink (NRD 1) and Uplink (NRD 2), minimum arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -DLIP=10.0.128.114 -
DLRP=9001 -DLNDT=MS2710xA -DLF=381837500 -ULIP=10.0.128.119 -ULRP=9000 -ULNDT=EM100 -
ULF=381837500

➢ Same configuration as with Downlink (NRD) and Uplink (USB SDR), minimum arguments except 
that the EM100 network recording device is used for uplink recording.

Downlink (NRD 1) and Uplink (NRD 2), recommended arguments:

MultiAnalyzerRecord.exe -DLF=391837500 -F=”C:\MyRecordFile.maf” -DLIP=10.0.128.114 -
DLRP=9001 -DLNDT=MS2710xA -DLF=381837500 -ULIP=10.0.128.119 -ULRP=9000 -ULNDT=EM100 -
ULF=381837500 -ULG=49 -ULFS=0 -DLG=380 -DLFS=345 -NDSO-14500

➢ Same configuration as with Downlink (USB SDR) and Uplink (NDR), recommended arguments, 
except that the EM100 network recording device is used for uplink recording.

Downlink (NRD 1) and Uplink (NRD 1):

 Due to hardware limitations, this configuration is not supported at the moment. It will be 
available as soon as it is supported by the hardware.
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5.4 Analyse an Earlier Recorded File

All recorded data is automatically stored in the record file with the extension “.maf”. There is no need to 
additionally save the result file. To reanalyse and generate the protocol output again, take the file and drop 
it on the wanted programme (“Drag and Drop”) (see 63):

Illustration 63 Analysing via "Drag and Drop"

Depending on the analysing programme, the data is handled as follows:

Name Description

MultiAnalyzerProto Programme to analyse the protocol content of the file. The programme 
creates a resulting text file in the same path. The text file can also be loaded 
into the MultiAnalyzerMsc.

MultiAnalyzerMsc Programme to analyse the protocol content of the file and to show the result 
in a message sequence chart.

MultiAnalyzerQoS Programme to analyse the protocol content of the file and to graphically 
present the statistic results in the form of diagrams, charts and tables.

Table 28 Analysing earlier recorded Data
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5.5 MultiAnalyzerProto

A possibility to ananlyse the protocol content of a file is to use the DOS application MultiAnalyzerProto. The 
programme creates a resulting text file in the same path. The resulting text file can also be loaded into the 
MultiAnalyzerMsc.

There is no overview of all available start arguments. The type is defined by the argument sequence.

The following chapters provide an overview of the command line arguments to analyse with 
MultiAnalyzerProto.
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5.5.1 Analyse Protocol Data

The start arguments are set in a static sequence. No arguments can be omitted, but argument can declared 
as unused with a blank “”. At the end, unused arguments can be left out.

Minimum Arguments

Path and file name 
for the record data.

• The first argument in sequence in the recorded file.
• Or in real-time recording file with the data, for that use the prefix 

keyword “ONLINE:Path+File”.

Optional Arguments

Protocol filter

A number (decimal) of the wanted protocol filter, see:
• 5.5.2     Protocol Filter DMR  
• 5.5.3     Protocol Filter TETRA  
• 5.5.4     Protocol Filter TETRA-DMO  

In any case, the value 0 means no filter is active. If this argument is not set 
the standard filter settings are used.

Path and file name 
for the configuration 
of AIE guessing

Path and file name of the configuration AIE guessing settings. If this 
argument is not set no AIE guessing is done.

Path and file name 
for the configuration 
of AIE settings.

Path and file name of the configuration AIE decryption settings. If this 
argument is not set no AIE decrypting is done.

Path and file name 
for an external 
analyse DLL.

Path and file name of a user build external analyse DLL. The DLL can export 
data, analyse and print unsupported parts of the protocol and replace parts 
of the internal MultiAnalyzer protocol analysis.

Table 29 MultiAnalyzerProto: Arguments for Analysing Protocol Data

Examples

Minimum arguments:

MultiAnalyzerProto.exe "C:\Record\Example.maf”

Minimum arguments (with real-time analysing):

MultiAnalyzerProto.exe "ONLINE:C:\Record\Example.maf”
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All arguments:

MultiAnalyzerProto.exe "C:\Record\Example.maf” 0 “C:\Settings\AieGuess.taie” “C:\Settings\
Aie.csv” „C:\DLL\MyAnalyse.dll“

Unused arguments:

MultiAnalyzerProto.exe "C:\Record\Example.maf” “” “” “” „C:\DLL\MyAnalyse.dll“
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5.5.2 Protocol Filter DMR

Different protocol option are available. An activated option will suppress redundant/unwanted data. Every 
option is unique number. These numbers are organized as logical bitmaps. This allows them to be logically 
linked to "OR" or simply added.

The standard value for DMR is 111088 (decimal) and defines follow options:

TS/TDMA1 Filter: “Suppress IDLE-PDU”, “Suppress Equal Broadcast”, “Suppress L2 Channel Data”, 
“Suppress blank Bursts”, “Suppress Late Entry”

MS/TDMA2 Filter: “Suppress IDLE-PDU”, “Suppress Equal Broadcast”, “Suppress L2 Channel Data”, 
“Suppress blank Bursts”, “Suppress Late Entry”

Filter DMR

General

0x00000001(16) 1(10) Suppress Slot 1

0x00000002(16) 2(10) Suppress Slot 2

TS/TDMA1 Filter

0x00000010(16) 16(10) Suppress IDLE-PDU

0x00000020(16) 32(10) Suppress Equal Broadcast

0x00000040(16) 64(10) Suppress L2 Channel Data

0x00000080(16) 128(10) Suppress blank Bursts

0x00000100(16) 256(10) Suppress Late Entry

MS/TDMA2 Filter

0x00001000(16) 4096(10) Suppress IDLE-PDU

0x00002000(16) 8192(10) Suppress Equal Broadcast

0x00004000(16) 16384(10) Suppress L2 Channel Data

0x00008000(16) 32768(10) Suppress blank Bursts

0x00010000(16) 65536(10) Suppress Late Entry
Table 30 MultiAnalyzerProto: Filter DMR
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5.5.3 Protocol Filter TETRA

Different protocol option are available. An activated option will suppress redundant/unwanted data. Every 
option is unique number. These numbers are organized as logical bitmaps. This allows them to be logically 
linked to "OR" or simply added.

The standard value for TETRA is 4080 (decimal) and defines follow options:

Downlink: “Suppress NULL-PDU at the End”, “Suppress equal Broadcasts”, “Suppress Equal D-NWRK 
PDUs”, “Suppress blank bursts”

Uplink: “Suppress U-Plane PDUs”, “Suppress NULL-PDU at the End”, “Suppress Blank Bursts”, 
“Suppress U-Plane PDUs”

Filter TETRA

General (Downlink and Uplink)

0x00000001(16) 1(10) Suppress Slot 1

0x00000002(16) 2(10) Suppress Slot 2

0x00000004(16) 4(10) Suppress Slot 3

0x00000008(16) 8(10) Suppress Slot 4

Downlink Filter

0x00000010(16) 16(10) Suppress NULL-PDU at the End

0x00000020(16) 32(10) Suppress equal Broadcasts

0x00000040(16) 64(10) Suppress equal D-NWRK PDUs

0x00000080(16) 128(10) Suppress blank bursts

0x00000100(16) 256(10) Suppress U-Plane PDUs

Uplink Filter

0x00000200(16) 512(10) Suppress NULL-PDU at the End

0x00000400(16) 1024(10) Suppress Blank Bursts

0x00000800(16) 2048(10) Suppress U-Plane PDUs

External Analyse DLL Filter

0x00010000(16) 65536(10) Suppress External Analyse DLL User defined 1

0x00020000(16) 131072(10) Suppress External Analyse DLL User defined 2
Table 31 MultiAnalyzerProto: Filter TETRA
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5.5.4 Protocol Filter TETRA-DMO

Different protocol option are available. An activated option will suppress redundant/unwanted data. Every 
option is unique number. These numbers are organized as logical bitmaps. This allows them to be logically 
linked to "OR" or simply added.

The standard value for TETRA-DMO is 110592 (decimal) and defines follow options:

Protocol related filter: “Suppress Blank Bursts”, “Suppress Blank Bursts”, “Suppress U-Plane PDUs”, 
“Suppress Equal DPres-Sync”

Filter TETRA-DMO

General

0x00000001(16) 1(10) Suppress Slot 1

0x00000002(16) 2(10) Suppress Slot 2

0x00000004(16) 4(10) Suppress Slot 3

0x00000008(16) 8(10) Suppress Slot 4

Protocol related filter

0x00000010(16) 16(10) Suppress No Call Blank Bursts

0x00001000(16) 4096(10) Suppress Blank Bursts

0x00002000(16) 8192(10) Suppress Repeated PDUs

0x00004000(16) 16384(10) Suppress Late Entry PDUs

0x00008000(16) 32768(10) Suppress U-Plane PDUs

0x00010000(16) 65536(10) Suppress Equal DPres-Sync
Table 32 MultiAnalyzerProto: Filter TETRA-DMO
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5.6 MultiAnalyzerMsc

The MultiAnalyzerMsc is used to load the text result files and graphically present the data in the form of 
message sequence charts.

This chapter provides an overview of the interface and menus of the MultiAnalyzerMsc.

1e

3e

2e

4e

5e

Illustration 64 MultiAnalyzerMsc: Interface

No Description

1e The menu bar.

2e The data is displayed layer depended. The layer names are shown at the top.

3e The text field shows the PDU.

4e

In the middle the protocol PDUs are shown. A yellow arrow means uplink, a green one 
means downlink.

• Click once to show the analysed protocol in the text window below.
• Double-click to show the time point in the QoS viewer.

5e The info column contains general data like frame, time and subscriber number.
Table 33 MultiAnalyzerMsc: Interface
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Menu ‘File’

Illustration 65 MultiAnalyzerMsc: Menu ‘File’

Name Key Combination Description

Load Result File... Ctrl+O Load a file. Loading stops at the end of the file.

Reload Current Result 
File

F5
Reload the current result file. The programme stops 
loading at the end of the file and tries to restore the 
current view position.

Load Result Stream... Ctrl+S
Load a file. The programme does not stop loading at the 
end of file and waits that new data is appended to the 
file (real-time online view).

Toggle Auto Scroll Ctrl+Space

Toggle auto scrolling. The last message is automatically 
shown if auto scrolling is enabled.

 Only available in real-time online view.

Load Recent None
Load a recent file if files already have been viewed. 
Show a list to pick the recent file.

Stop Loading Ctrl+X Stop loading.

Quit Ctrl+Q Quit the programme.
Table 34 MultiAnalyzerMsc: Menu ‘File’
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Menu ‘Edit’

Illustration 66: MultiAnalyzerMsc: Menu ‘Edit’

Name Key Combination Description

Copy Frame Number F Copy frame information to clipboard.

Copy Time T Copy time information to clipboard.

Copy Address A Copy address information to clipboard.

Copy PDU Name N Copy the selected PDU name to clipboard.

Copy PDU Text P Copy (unformatted) text to clipboard.

Copy PDU overview W Copy text representation of MSC to clipboard.

Copy a part of the file Ctrl+W
Select a time range via Messages and copy the text 
representation of the MSC to the clipboard.

Extract a part of the file Ctrl+E
Choose by message a range. Start with this 
information the MultiAnalyzerSplitter.

Table 35 MultiAnalyzerMsc: Menu ‘Edit’
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Menu ‘Search’

Illustration 67 MultiAnalyzerMsc: Menu ‘Search’

Name Key Combination Description

Find... Ctrl+F
Open the search dialogue for settings (see 
chapter 5.6.1     Search Dialogue   
(MultiAnalyzerMsc)).

Find Next F3 Search forward with unchanged settings. 

Find Previous Shift+F3 Search backward with unchanged settings. 

Next Layer Message Shift+Down
Search forward for the next message in the 
same layer as the selected message.

Previous Layer Message Shift+Up
Search backward for the last message in the 
same layer as the selected message.

Next Equal Message Name Ctrl+Down
Search forward for the next message with same 
PDU name as the selected message.

Previous Equal Message Name Ctrl+Up
Search backward for the last message with 
same PDU name as the selected message.

Next Equal Address Message Alt+Down
Search forward for the next message with same 
subscriber identity as the selected message.

Previous Equal Address 
Message

Alt+Up
Search backward for the last message with 
same subscriber identity as the selected 
message.

View Moment in QoS Viewer Ctrl+V View selected PDU in MultiAnalyzerQoS.
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Name Key Combination Description

Synchronize the display with None

Shows the best possible next time in the own 
display at which the current display comes 
closest to the selected other MSC. If changes 
are made to the other MSC, the display of your 
own MSC is updated in real time.

Table 36 MultiAnalyzerMsc: Menu ‘Search’
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Menu ‘Bookmarks’

Illustration 68 MultiAnalyzerMsc: Menu  
‘Bookmarks’

Name Key Combination Description

Save Bookmark 1 Shift+1 Save the selected cursor position.

Goto Bookmark 1 1 Return to the saved cursor position.

...

Save Bookmark 10 Shift+0 Save the selected cursor position.

Goto Bookmark 10 0 Return to the saved cursor position.
Table 37 MultiAnalyzerMsc: Menu ‘Bookmarks’
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Menu ‘Protocol’

Illustration 69 MultiAnalyzerMsc: Menu 
‘Protocol’

Name Description

TETRA
Open protocol filter settings (see chapter 5.6.3     Protocol Filter   
Settings).

TETRA-DMO

DMR

Load… Load settings from a file.

Save… Save settings to a file.

TETRA Subscriber to Name... See chapter 5.6.4     TETRA Subscriber to Name  .

TETRA external analyse DLLs...
Choose up to eight user build external analyse DLL. The DLLs can 
export data, analyse and print unsupported parts of the protocol 
and replace parts of the internal MultiAnalyzer protocol analysis.

Encrypt AIE Configuration File

Encrypts an AIE configuration text file to hide its contents (i.e. the 
keys). Attention: The file cannot be decrypted and therefore 
cannot be put back into text form! However, the (decrypted) 
content is temporarily used internally. A dongle is required for 
encryption/decryption. When encrypting, the user determines 
which dongle may decrypt the file again for internal use.

Table 38 MultiAnalyzerMsc: Menu ‘Protocol’

 TETRA AIE options and the MASDecryptor are described in another document.

Menu ‘Windows’
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Illustration 70 MultiAnalyzerMsc: 
Menu ‘Windows’

Name Description

Message Sequence Charts
Show or hide the window that contains the message sequence 
charts of the loaded data.

Message Info
Show or hide the window that contains the information about the 
selected PDU.

Table 39 MultiAnalyzerMsc: Menu ‘Windows’

Menu ‘View’

Illustration 71 MultiAnalyzerMsc: Menu ‘View’
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Name Key Combination Description

Save Windows none

Save current window positions.

 At the next start this window positions 
are reused.

Restore Windows none Reuse previous stored window positions now.

Toggle Full Screen F11 Toggle maximum size (full screen) view.

Clean All Messages Shift+C

Clean all messages from view and free used memory.

 Makes sense in real-time online view.

The user can concentrate on new messages without a 
large history of old messages. The data that is contained 
in the file stays untouched.

View Time as UTC none Note time in current local time or UTC.

Colour Settings none

Change the colour of the 
message charts.
Edit: Open colour 
selection dialogue, to edit 
the colour.
Reset: Set back to factory 
default.
Cancel: Close settings 
dialogue without saving.
Ok: Confirm new settings.

Increase MSC Font Ctrl+PgUp Increase the font size.

Decrease MSC Font Ctrl+PgDown Decrease the font size.

Language none Change the interface language.

Open User Guide Ctrl+H Open the user manual.

About Qt... none Show information about the used tool set.

About Argon... none Show information about the used source code package.

About MSC... none
Show information about the MultiAnaylzerMsc 
themselves.

Table 40 MultiAnalyzerMsc: Menu ‘View’
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5.6.1 Search Dialogue (MultiAnalyzerMsc)

The search dialogue allows to set the search options. Different types of options are possible. They can be 
enabled or disabled with the checkboxes. If more than one option is enabled, both/all conditions need to be 
true.

● Open the search dialogue via ‘Search’ > ‘Find...’ or use the key combination Ctrl+F.

Illustration 72 MultiAnalyzerMsc: Search Dialogue

© 2022 femvenner GmbH 78/247



Record and View Protocol Data

Name Description

6e Button to close the window.

7e Buttons to start searching backward/forward from the current position.

8e Finds message of a specific type, e.g. TETRA downlink, TETRA uplink.

9e

Goes to/searches for a frame. Numbers from 0 to 9 are allowed.
The format is:
“Hyperframe :Multiframe : Frame :Slot”
“(00000-65535) :(01-60) :(01-18) :(1,2,3,4)”
Empty fields mean any value.
Examples:
“00001:01:01:1” → All fields filled, go to exact frame.
“_____:01:01:1” → Hyperframe field is not filled, find all frames without hyper frame 

information.
“_____:__:__:1” → Only slot information is filled. Find next slot 1.

10e Search (case sensitive) for a text in the analysed element section.

11e

Search for the message name. All occurred messages are listed in the drop-down list. 
Unchecking "Subtypes" causes messages to be searched for in general. For example, if 
instead of a "MAC-RESOURCE (aie)" all "MAC-RESOURCE" with or without bracket extension 
should be found.

Table 41 MultiAnalyzerMsc: Search Dialogue
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5.6.2 Copy a part of the MAF file

The mask allows you to select the time range to be copied. For this purpose messages from the analysis are 
used. The time stamp of the message is used to select the start and end point. It is also possible to insert an 
extra period before or after the selected time as security buffer. As with the MultiAnalyzerSplitter the name 
scheme and the target file are then specified.

For the messages that can be selected in the mask there are different types:

Name Description

First message The first message in the log.

Last messafge The last message in the log.

Visible beginning The first message in the current view of the log.

Visible end The last message in the current view of the log.

Cursor The message under the cursor.

Bookmark
1 to 10

The saved message of the bookmark.

Table 42 MultiAnalyzerMsc: Copy a part of the MAF file, Message types

● Open the search dialogue via ‘Edit’ > ‘Extract a part of the file...’ or use the key combination Ctrl+E.
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Illustration 73 MultiAnalyzerMsc:Copy a part of the MAF file, Input mask

Name Description

12e Message that determines the start time of the range.

13e A period of time that is to be additionally copied previously the selected time.

14e Message that determines the end time of the range.

15e A period of time that is to be additionally copied after the selected time.

16e Schema of the target file name.

17e Path and name of the target file.

18e Button to close the window.

19e
Start saving, the MultiAnalyzerSplitter is started with the selected parameters and saves 
the range without further questions.

Table 43 MultiAnalyzerMsc: Copy a part of the MAF file, Input mask
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5.6.3 Protocol Filter Settings

Many redundant protocol information are sent over the air. The filter options help to suppress them and 
allow the user to focus on the important signalling. Before the analysis starts, the user is requested to 
define the filter options:

 A selected option suppresses the described type of information.

Illustration 74 MultiAnalyzerMsc: Protocol Filter Settings TETRA

Illustration 75 MultiAnalyzerMsc: Protocol Filter Settings TETRA-DMO
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Illustration 76 MultiAnalyzerMsc: Protocol Filter Settings DMR

Some conventions:

“DL”, “TS/TDMA1”: Affects only the downlink direction.

“UL”, “MS/TDMA2”: Affects only the uplink direction.

No specific direction indication means affects all directions.
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5.6.4 TETRA Subscriber to Name

TETRA subscriber numbers are in the range of 1 to 16777215. A translation file can translate the numbers 
into names. The translation data is stored into a CSV formatted file. With the help of the selection dialogue, 
the translation file can be loaded. This translation file automatically loads at every programme start.

If the selection process of the file is cancelled, the user is asked if the automatic loading during the 
programme start should also be deleted.

 For the file format see chapter Subscriber to Name – File Format.
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5.7 MultiAnalyzerQoS

The MultiAnalyzerQoS is used to load the record file (e.g. the maf-file) and to graphically present the data 
in the form of diagrams, charts and tables.

This chapter provides an overview of the MultiAnalyzerQoS interface and menus.

4f

1f 2f

3f

Illustration 77 MultiAnalyzerQoS: Interface

No Description

1f The menu bar.

2f The time toolbar (see chapter 5.7.12     Toolbar  ).

3f Main window to show the layout pages and their selected sub windows.

4f
Bar to set layout settings (see chapter Naming the User Layout) or to add sub windows (see 
chapter Adding a Sub Window).

Table 44 MultiAnalyzerQoS: Interface
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Menu ‘File’

Illustration 78 MultiAnalyzerQoS: Menu ‘File’

Name Key Combination Description

Load Record File... Ctrl+O
Load a file. The programme stops loading at the end 
of the file.

Load Record Stream... Ctrl+S
Load a file. The programme does not stop loading at 
the end of the file and waits until new data is 
appended to the file (real-time online view).

Receive Network 
Stream...

Ctrl+N
Open a window to start a real-time network stream 
(see chapter 5.7.10     Starting Real-Time QoS Stream  ).

Load Recent none List with the last ten files.

Toggle Auto Scroll Ctrl+Space

Toggle auto scrolling. The programme automatically 
scrolls with the current time if auto scrolling is 
enabled.

 Only available in real-time online view.

File Load Information Ctrl+I
Show details about loaded or received QoS 
information.

Stop Loading Ctrl+X Stop loading.

Quit Ctrl+Q Quit the programme.
Table 45 MultiAnalyzerQoS: Menu ‘File’
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Menu ‘Settings’

Illustration 79 MultiAnalyzerQoS: Menu 
‘Settings’

Name Description

Disable edit QoS 
Settings...

Disable the possibility to edit the 
QoS settings. If the settings are 
disabled, only the window positions 
can be changed.
To disable the settings, a password is 
requested, which is also used to 
enable the settings again.
The password have to be entered 
twice, when it is set, to protect 
against incorrect entries.

View Time as UTC Draw time in current local time or UTC format.

Number of Layout 
Tabs...

How many possible views for layouts should be displayed. The range starts 
with only one view and allows up to ten.

Python Scripts...
Opens settings for Python script support. See chapter 5.7.9 Python 
Configuration.

Load Settings...
Load settings from a file. For encrypted saving, see chapter 7 
MultiAnalyzerSaveRules).

Save Settings... Save the settings as a file.

Load Recent Settings Load settings that have been made recently.
Table 46 MultiAnalyzerQoS: Menu ‘Settings’
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Menu ‘Settings’ (CCCH)

Illustration 80 MultiAnalyzerQoS: 
Menu ‘Settings’ (CCCH)

Name Description

CCCH QoS Groups... See chapter 5.7.2     CCCH QoS Groups  .

CCCH Combine 
Seconds...

Resolution of CCCH Load in seconds 
(1 to 10s).
Multiple seconds create an average 
value.

CCCH Max...

Set the maximum value of the CCCH 

views (10 to 100%).

CCCH Top Mobiles...

Define the number of radios that are 
listed in the MCCH/SCCH top 
instances UL/DL list.

Table 47 MultiAnalyzerQoS: Menu ‘Settings’ (CCCH)
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Menu ‘Settings’ (TCH)

Illustration 81 MultiAnalyzerQoS: Menu 
‘Settings’ (TCH)

Name Description

TCH Load Groups... See chapter 5.7.3     TCH QoS Load Groups  .

TCH Load Combine 
Seconds...

Resolution of TCH Load in seconds 
(1 to 10s).
Multiple seconds create an average 
value.

TCH Load Max…

Set the maximum value of the 
TCH views (10 to 100%).

TCH Load Top 
Mobiles….

Define the number of radios that 
are listed in the MCCH/SCCH top 
instances UL/DL list.

TCH Call Colours... Change the draw colour of the ‘TCH 
Load’ view:
Colour: Fill colour
Outline: Line around fill area
Text: Legend text colour

Edit: Open colour selection 
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Name Description

dialogue, to edit the colour.
Reset: Set back to factory default.
Cancel: Close settings dialogue 
without applying the changes.
Ok: Apply changes.

TCH Call Top  
Colours...

Change the colours of the ‘TCH Top 
Call List’:
Colour: Fill colour
Text: Legend text colour

Edit: Open colour selection 
dialogue, to edit the colour.
Reset: Set back to factory default.
Cancel: Close settings dialogue 
without applying the changes.
Ok: Apply changes.

TCH Call Max...

Set the maximum value of ‘TCH 
Load’ (2 to 64). The value 
represents available slots of the 
cell. Every radio adds 4 slots. 
Decrease this slots by the number 
of used control channels (MCCH 
and SCCH). The resulting value 
influences the views and TCH 
Capacity Call Usage directly.

TCH Call P2P Time...

The P2P call duration can not be 
measured in all cases. For uncertain 
conditions, set a guessed value for 
the call duration.
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Name Description

TCH Erlang C 
Colours...

Up to eight different sections can 
be set. Every section can be 
activated/deactivated with the 
checkbox. The percentage can 
individually be set and the previous 
section ends with the start of the 
next one.

Change the colours of the ‘TCH 
ErlangC’ view:
Colour: Fill colour
Text: Legend text colour

Edit: Open colour selection 
dialogue, to edit the colour.
Reset: Set back to factory default.
Cancel: Close settings dialogue 
without applying the changes.
Ok: Apply changes.

TCH Erlang C call 
length...

Define an average call length for 
the Erlang C calculation.

Table 48 MultiAnalyzerQoS: Menu ‘Settings’ (TCH)
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Menu ‘Settings’ (Cell Change)

Illustration 82 MultiAnalyzerQoS: 
Menu ‘Settings’ (Cell Change)

Name Description

Cell Change 
Colours...

Change the draw colour of the 
‘Cell Change’ view:
Colour: Fill colour
Outline: Line around fill area
Text: Legend text colour

Edit: Open colour selection 
dialogue, to edit the colour.
Reset: Set back to factory default.
Cancel: Close settings dialogue 
without applying the changes.
Ok: Apply changes.

Cell Change Max...

Set the maximum value of the cell 
change view (1 to N).

Cell Change Top 
Mobiles….

Define the number of mobiles that 
are listed in the top cell change 
list.

Table 49 MultiAnalyzerQoS: Menu ‘Settings’ (Cell Change)
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Menu ‘Settings’ (User-Defined Msg)

Illustration 83 MultiAnalyzerQoS: 
Menu ‘Settings’ (User-Defined Msg)

Name Description

User-Defined Msg 
{1-5} Groups...

See chapter 5.7.4     User Defined Messages {1-5} Groups  .

User-Defined Msg 
{1-5} Max...

Set the maximum value of the bars 
(1 to N).

Table 50 MultiAnalyzerQoS: Menu ‘Settings’ (User-Defined Msg)
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Menu ‘Settings’ (TETRA)

Illustration 84 MultiAnalyzerQoS: Menu 
‘Settings’ (TETRA)

Name Description

Encrypt AIE 
Configuration File...

Encrypts an AIE configuration text file to hide its contents (i.e. the keys). 
Attention: The file cannot be decrypted and therefore cannot be put back 
into text form! However, the (decrypted) content is temporarily used 
internally. A dongle is required for encryption/decryption. When encrypting, 
the user determines which dongle may decrypt the file again for internal use.

TETRA Subscriber 
to Name…

See chapter 5.7.5     TETRA Subscriber to Name Dialogue (MultiAnalyzerQoS)  .

TETRA Defined 
Calls…

See chapter 5.7.6 TETRA Defined Calls Dialogue (MultiAnalyzerQoS).

TETRA Uplink 
Simulation...

See chapter 5.7.7     The Uplink Simulation  .

TETRA external 
analyse DLLs...

Choose up to eight user build external Analyse-DLL. The DLLs can export data, 
analyse and print unsupported parts of the protocol and replace parts of the 
internal MultiAnalyzer protocol analysis.

MASDecryptor 
Status...

Displays the connection status and enabled options.

Table 51 MultiAnalyzerQoS: Menu ‘Settings’ (TETRA)

 TETRA AIE options and the MASDecryptor are described in another document.

Menu ‘Search’
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Illustration 85 MultiAnalyzerQoS: 
Menu ‘Search’

Name Key Combination Description

Find... Ctrl+F
Open the search dialogue (see chapter 5.7.8     Search   
Dialogue (MultiAnalyzerQoS)).

Find Next F3 Search the next item with the same settings.

Find Previous Shift+F3 Search the previous item with the same settings.
Table 52 MultiAnalyzerQoS: Menu ‘Search’
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Menu ‘Bookmarks’

Illustration 86 MultiAnalyzerQoS: 
Menu ‘Bookmarks’

Name Key Combination Description

Save Bookmark 1 Shift+1 Save the selected cursor position.

Goto Bookmark 1 1 Return to the saved cursor position.

...

Save Bookmark 10 Shift+0 Save the selected cursor position.

Goto Bookmark 10 0 Return to the saved cursor position.
Table 53 MultiAnalyzerQoS: Menu ‘Bookmarks’
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Menu ‘Windows’

Illustration 87 MultiAnaylzerQoS: Menu ‘Windows’

Show available sub windows that include the measuring results. If the name is selected, the window is 
visible. The sub windows can be added or closed via the menu section ‘Windows’ or like it is described in 
chapter Adding a Sub Window and Closing a Sub Window.

Menu ‘View’

Illustration 88 MultiAnalyzerQoS: Menu ‘View’
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Name Key Combination Description

Save Windows none

Save current window position.

 At the next programme start this windows 
position are reused.

Restore Windows none Reuse formerly stored window position now.

Toggle Full Screen F11 Toggle maximum size (full screen) view.

Toggle Transparence Shift+F11 Toggle the transparence of the viewed background.

Enable OpenGL 
Acceleration

none

Draw with OpenGL instead of raster engine.

 Do not work in parallel with activated 
transparence option. 

 Works only if a windows graphic driver with 
OpenGL support is installed.

Clean All Messages Shift+C

Clean all messages from view and free used memory.

 Makes sense in real-time online view.

The user can concentrate on new messages without a 
large history of old messages. The data that is contained 
in the file stays untouched.

Open User Guide Ctrl+H Open the user manual.

Language none Change the interface language.

About Qt... none Show information about used tool set.

About Argon… none Show licence information of used Argon algorithm.

About QoS... none Show information about the MultiAnalyzerQoS.
Table 54 MultiAnalyzerQoS: Menu ‘View’
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5.7.1 Layout Configuration

After initial start the MultiAnalyzerQoS is not configured.

Illustration 89 MultiAnalyzerQoS: Layout

The different layout pages can be renamed and adjusted by adding, moving and closing the sub windows.


The layout of the pages can individually be stored and restored. Otherwise the last changes that 
were made on the layout page, will be displayed at the next programme start.

The following chapters provide an overview about the possibilities of personalising the layout:

• Adding a Sub Window  

• Moving a Sub Window  

• Detaching and Reintegrating a Sub Window  

• Closing a Sub Window  

• Naming the User Layout  
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Adding a Sub Window

All not visible sub windows can be added to the chosen layout page in the main window.


The layout of the pages can individually be stored and restored. Otherwise the last changes that 
were made on the layout page, will be displayed at the next programme start.

To add a sub window, follow the next steps.

1. Choose a window from the drop-down list at the left bottom (see 90).

Illustration 90 MultiAnalyzerQoS: Drop-Down 
List

2. To add the chosen sub window, click on the button .

✔ The chosen window is added to the layout page in the main window (see 91).

Illustration 91 MultiAnalyzerQoS: Adding Sub Window


Depending on the protocol, not all measurement windows have a function. These inactive 

windows are marked as disabled like: 

 It is also possible to add the windows via the menu section ‘Windows’ (see Chapter 5.7 
MultiAnalyzerQoS).

 To close a sub window, see chapter Closing a Sub Window.

 To move or detach a sub window, see chapter Moving a Sub Window and   Detaching and   
Reintegrating a Sub Window.
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Moving a Sub Window

Sub windows can be moved within the main window to adjust the view of the layout page.


The layout of the pages can individually be stored and restored. Otherwise the last changes that 
were made on the layout page, will be displayed at the next programme start.

To move a sub window, follow the next steps.

➔ Sub windows are opened in MultiAnalyzerQoS.

 To add sub windows, see chapter Adding a Sub Window.

1. Click left on the title bar of the sub window (see 92) and hold the mouse button.

Illustration 92 MultiAnalyzerQoS: Title Bar

2. To change the position of the sub window, drag the sub window on the wanted position.

✔ The new position is marked (see 93).

Illustration 93 MultiAnalyzerQoS: Drag Sub Window

3. Drop the sub window.
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✔ The position of the sub window is changed (see 94).

Illustration 94 MultiAnalyzerQoS: Drop Sub Window

 To close a sub window, see chapter Closing a Sub Window.
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Detaching and Reintegrating a Sub Window

It is possible to detach a sub window from the main window and to reintegrate the sub window to the main 
window again.


The layout of the pages can individually be stored and restored. Otherwise the last changes that 
were made on the layout page, will be displayed at the next programme start.

To detach and reintegrate a sub window, follow the next steps.

➔ Sub windows are opened in MultiAnalyzerQoS.

 To add sub windows, see chapter Adding a Sub Window.

1. To detach the sub window from the main window, click on the button  in the title bar of the sub 
window (see 95).

Illustration 95 MultiAnalyzerQoS: Title Bar Detach

✔ The sub window is detached and movable (see 96).

Illustration 96 MultiAnalyzerQoS: Detach Sub Window
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2. To reintegrate the window, drag the sub window back into the main window (see chapter    Moving a   
Sub Window).

✔ The new position is marked (see 97).

Illustration 97 MultiAnalyzerQoS: Drag Sub Window

3. Drop the sub window.

✔ The sub window is positioned where the sub window has been dropped.

 To close a sub window, see chapter Closing a Sub Window.
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Closing a Sub Window

Every sub window can be closed individually.


The layout of the pages can individually be stored and restored. Otherwise the last changes that 
were made on the layout page, will be displayed at the next programme start.

To close a sub window, follow the next step.

➔ Sub windows are opened in MultiAnalyzerQoS.

 To open sub windows, see chapter Adding a Sub Window.

● To close a sub window, click on the button  in the title bar of the sub window (see 98).

Illustration 98 MultiAnalyzerQoS: Close Sub Window

✔ The window is closed.
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Naming the User Layout

Up to five different layouts can be saved. The layouts are presented in a tab sidebar at the bottom on the 
right. Switching to another layout, stores the current view and loads the chosen one. Every layout can 
individually be named.


The layout is permanently stored at the computer. Every layout can have a custom setting for the 
background transparency. The global settings can be used as well as the transparency can be 
switched on or off.

To name the layout, follow the next steps.

1. To open the dialogue for the name change, double-click on the corresponding tab page in the tab 
sidebar (see 99).

Illustration 99 MultiAnalyzerQoS: Tab Page Sidebar

✔ The dialogue opens (see 100).

Illustration 100 MultiAnalyzerQoS: Layout Name
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2. To change the name of the layout page, enter a name into the text field and click on the button [Ok].

✔ The name of the tab page is changed (see 101).

Illustration 101 MultiAnalyzerQoS: Tab Changed Name

 To adjust the different layout pages, see chapter Adding a Sub Window, Moving a Sub Window, 
Detaching and Reintegrating a Sub Window and Closing a Sub Window.
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5.7.2 CCCH QoS Groups

This chapter provides an overview of the CCCH Load view settings dialogue. For further information see 
chapter TETRA: CCCH Load DL/UL and DMR: Channel Load.

● Open the settings dialogue via ‘Settings’ > ‘CCCH’ > ‘CCCH QoS Groups...’.

5f 6f 7f 8f

9f

10f

11f

12f

13f14f15f16f17f18f

Illustration 102 MultiAnalyzerQoS: CCCH QoS Groups
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No Description

5f
Drop-down list to select the direction (downlink/uplink). All data are handled 
independently.

6f List with available unused PDU types.

7f
Checkbox to declare group as default group. All unassigned messages are automatically 
added to this group.

8f Drop-down list to select the current group.

9f

Text field to change the current group name and buttons to move the group position 
(up/down) within the list.
The list items will be shown on the bottom of the viewed window. The first item in the list is 
the last one in the window list and vice versa.

10f
Section to change the draw colour. Left is the fill colour, mid is the outline colour, right is the 
text colour.

11f The list with the assigned PDUs to the group.

12f Button to remove the selected assigned PDU from the current group.

13f Button to cancel the current settings dialogue.

14f Button to apply the current settings.

15f Button to reset the settings to factory default.

16f Button to add the selected unassigned PDU to the current group.

17f Button to save the current settings to a file.

18f Button to load the settings from a file.
Table 55 MultiAnalyzerQoS: CCCH QoS Groups
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Downlink and Uplink QoS Groups

This chapter provides an overview of the different QoS groups.

Illustration 103 MultiAnalyzerQoS: DL and UL QoS Groups

At the left side the list of available messages is shown. At the right side there are the settings and the 
assigned PDUs. One mandatory group is defined by default. The ‘Default Group’ is used for all PDUs that 
are not assigned to a user-defined group. This ensures that all occurred signalling is shown.
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Depending on the direction type, only PDUs are listed that are available for the chosen direction. In case of 
the uplink direction, four additional none PDUs are listed:

Illustration 104 MultiAnalyzerQoS: None PDUs

Name Description

Not received All not received uplink PDUs are grouped into these groups. Not received PDUs 
are determined by:
• Unused “reserved slots”
• Random-Access Acknowledge without the reception of a corresponding uplink 

burst

TETRA:

AccessCode B Ordinary random access transmissions are using the AccessCode A configuration. 
The other Access Codes are typically reserved for priority access, like emergency 
calls or special groups access. If the infrastructure reserves too much uplink space 
for an optional Access Code, a bottleneck for the AccessCode A can occur. The 
viewed optional Access Code means the reserved space for that Access Code and 
not the effectively used space.

AccessCode C

AccessCode D
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5.7.3 TCH QoS Load Groups

This chapter provides an overview of the TCH Load view settings dialogue. For further information see 
chapter TETRA: TCH QoS Load DL/UL.

● Open the settings dialogue via ‘Settings’ > ‘TCH’ > ‘TCH Call Groups...’.

Illustration 105: MultiAnalyzerQoS: TCH Load Groups
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No Description

5f
Drop-down list to select the direction (downlink/uplink). All data are handled 
independently.

6f List with available unused PDU types.

7f
Checkbox to declare group as default group. All unassigned messages are automatically 
added to this group.

8f Drop-down list to select the current group.

9f

Text field to change the current group name and buttons to move the group position 
(up/down) within the list.
The list items will be shown on the bottom of the viewed window. The first item in the list is 
the last one in the window list and vice versa.

10f
Section to change the draw colour. Left is the fill colour, mid is the outline colour, right is the 
text colour.

11f The list with the assigned PDUs to the group.

12f Button to remove the selected assigned PDU from the current group.

13f Button to cancel the current settings dialogue.

14f Button to apply the current settings.

15f Button to reset the settings to factory default.

16f Button to add the selected unassigned PDU to the current group.

17f Button to save the current settings to a file.

18f Button to load the settings from a file.
Table 56 MultiAnalyzerQoS: TCH Load Groups
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TCH Downlink and Uplink QoS Groups

This chapter provides an overview of the different TCH QoS groups.

Illustration 106 MultiAnalyzerQoS: DL and UL QoS Groups

At the left side the list of available messages is shown. At the right side there are the settings and the 
assigned PDUs. One mandatory group is defined by default. The ‘Default Group’ is used for all PDUs that 
are not assigned to a user-defined group. This ensures that all occurred signalling is shown.
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Depending on the direction type, only PDUs are listed that are available for the chosen direction. For traffic 
channel six additional PDUs and three none PDUs are listed:

Illustration 107: MultiAnalyzerQoS: 
TCH PDUs

Name Description

MAC-UPlane Received U-Plane signalling (E2E or for BDBOS: OPTA)

MAC-TCH/S Received TCH/S (Speech)

MAC-TCH Received TCH circuit mode data (TCH2.4, TCH4.8 or TCH7.2)

MAC-TCH 
NULL-PDU

Replaces TCH(/S) data:
• DL: Received in UL.
• DL: Replacing TCH(/S) load that wasn’t received from UL.
• UL: Send if no data from speech codec is present.

Not received All not received uplink signalling PDUs (but not TCH(/S) load) are grouped into 
these groups. Not received PDUs are determined by:
• Unused “reserved slots”
• Random-Access Acknowledge without the reception of a corresponding uplink 

burst

Not received 
TCH

Only for Uplink: SwiMi request TCH(/S) load from mobile. But this load wasn’t 
received (or not send by mobile).

TETRA:

AccessCode B Ordinary random access transmissions are using the AccessCode A configuration. 
The other Access Codes are typically reserved for priority access, like emergency 
calls or special groups access. If the infrastructure reserves too much uplink space 
for an optional Access Code, a bottleneck for the AccessCode A can occur. The 
viewed optional Access Code means the reserved space for that Access Code and 
not the effectively used space.

AccessCode C

AccessCode D

Table 57 MultiAnalyzerQoS: TCH-PDUs
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5.7.4 User Defined Messages {1-5} Groups

This chapter provides an overview of the user-defined messages groups settings dialogue.

19f 20f 21f 22f

23f

24f

25f

26f

27f28f29f30f31f

Illustration 108 MultiAnalyzerQoS: User Defined Messages Groups
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No Description

19f

Text field to replace the default window 
name.

20f List with available unassigned PDUs.

21f
Checkbox to activate/deactivate the time slot mask. If it is activated, only events are added 
that are received on the selected time slot(s).

22f Drop-down list to set the current group.

23f

Text field to change the current group name and buttons to move the group position 
(up/down) within the list.
The list items will be shown on the bottom of the viewed window. The first item in the list 
is the last one in the window list and vice versa.

24f
Section to change the draw colour. Left is the fill colour, mid is the outline colour, and right 
is the text colour.

25f List with the assigned PDUs to the group.

26f Button to remove the selected assigned PDU from the current group.

27f Button to apply the current settings.

28f Button to close the current settings dialogue.

29f Button to save the current settings to a file.

30f Button to add the selected unassigned PDU to the current group.

31f Button to load a definition from a file.
Table 58 MultiAnalyzerQoS: User Defined Messages Groups
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5.7.5 TETRA Subscriber to Name Dialogue (MultiAnalyzerQoS)

This chapter provides an overview of the subscriber to name dialogue in MultiAnalyzerQoS.

32f

33f

34f35f36f

Illustration 109 MultiAnalyzerQoS: Subscriber to Name

No Description

32f

Field that shows details about loaded files:
• Number of networks
• Number of subscriber
• Number of ranges

33f
Button to save the current loaded data. 
Useful if data is joined from multiple files. Sets the file for automatic loading at the next 
start.

34f Button to leave the dialogue.

35f
Button to load a file. The user is asked if the new data shall be joined to the previous data or 
if the previous data shall be replaced. The first file load sets the file for automatic loading at 
the next start.

36f Button to clean all data from database. Cleans also the automatic loading at the next start.
Table 59 MultiAnalyzerQoS: Subscriber to Name

 For the file format see chapter Subscriber to Name – File Format.
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Subscriber to Name – File Format

The main file format is CSV (Comma-Separated Values). The separator is the semicolon “;”.

The different values (exact subscriber or range definition) are stored in the following order:

Keyword Description

NETWORK

Defines the network for the keyword SSI and RANGE. All following values belong to 
this network.

Value Description

MCC Mobile Country Code (in range from 1 – 1023)

MNC Mobile Network Code (in range from 1 – 16383)

Example:
NETWORK;262;1001

SSI

Defines the name for a single SSI.

Value Description

SSI The SSI number (in range from 1 – 16777215).

Modulo View only the modulo part of the SSI, (0=Show full SSI, range from 1 – 
16777215).

Name The name of the subscriber.

Example:
SSI;5230025;0;John Doe

RANGE

If no exact match is possible but the subscriber is in a defined range (e. g. number block 
of an organisation), this range can be named. Overlapping ranges are possible. The first 
matching range is used. So define small sub-ranges before huge cover ranges.

Value Description

Start The beginning of the range (from 1 – 16777215)

End The end of the range (from 1 – 16777215).

Modulo View only the modulo part of the SSI, (0=Show full SSI, range from 1 – 
16777215).

Name The name of the range.

Example: RANGE;5000;5019;0;Fire fighters, Group A
RANGE;5020;5039;0;Fire fighters, Group B
RANGE;5040;5059;0;Fire fighters, Group C
RANGE;5000;5099;0;Fire fighters

Table 60 MultiAnalyzerQoS: Subscriber File Format
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5.7.6 TETRA Defined Calls Dialogue (MultiAnalyzerQoS)

This chapter provides an overview of the dialogue of defined calls in MultiAnalyzerQoS.

37f

38f

39f40f41f

Illustration 110 MultiAnalyzerQoS: Defined Calls

No Description

37f

Field that shows details about loaded files:
• Number of networks
• Number of subscriber
• Number of ranges

38f
Button to save the current loaded data. 
Useful if data is joined from multiple files. Sets the file for automatic loading at the next 
start.

39f Button to leave the dialogue.

40f
Button to load a file. The user is asked if the new data shall be joined to the previous data or 
if the previous data shall be replaced. The first file load sets the file for automatic loading at 
the next start.

41f Button to clean all data from database. Cleans also automatic loading at the next start.
Table 61 MultiAnalyzerQoS: Subscriber to Name

 For the file format see chapter Defined Calls – File Format.
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Defined Calls – File Format

The main file format is CSV (Comma-Separated Values). The separator is the semicolon “;”.

The different values (exact subscriber or range definition) are stored in the following order:

Keyword Description

NETWORK

Defines the network for the keyword SSI and RANGE. All following values belong to 
this network.

Value Description

MCC Mobile Country Code (in range from 1 –1023)

MNC Mobile Network Code (in range from 1 – 16383)

List-
Type

Defines the behaviour when an address is found or not.

0 White-List: Selects P2MP calls that are NOT in the list.

1 White-List: Selects P2P and P2MP calls that are NOT in the list.

4 Black-List: Selects P2MP calls that are IN the list.

5 Black-List: Selects P2P and P2MP calls that are IN the list.

Example:
NETWORK;262;1001;0

SSI

Defines the name for a single SSI.

Value Description

SSI The SSI number (in range from 1 – 16777215).

Example:
SSI;5230025

RANGE

If no exact match is possible but the subscriber is in a defined range (e. g. number block 
of an organisation), this range can be named. Overlapping ranges are possible. The first 
matching range is used. So define small sub-ranges before huge cover ranges.

Value Description

Start The beginning of the range (from 1 – 16777215)

End The end of the range (from 1 – 16777215).

Example:
RANGE;5000;5019

Table 62 MultiAnalyzerQoS: Defined Calls File Format
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5.7.7 The Uplink Simulation

Depending on the receiving prerequisite, not all uplink signalling can be received. The MultiAnalyzerQoS 
can simulate this not received uplink information. 

The simulated uplink messages are used for the uplink CCCH measurement, see chapters:

• TETRA: CCCH Load DL/UL and DMR: Channel Load  

• TETRA: CCCH Top Instances DL/UL and DMR: Top Instances  

• TETRA: CCCH Pie Chart (Load All) DL/UL and DMR: Pie Chart (Load All)  

• TETRA: CCCH Pie Chart (Load Usage) DL/UL and DMR: Pie Chart (Load Usage)  

Option ‘DL-PDU’

The simulation is based on known sequences. If a message is received at the downlink, this typically is a 
response to a prior corresponding uplink message or the request for a following uplink message (see 111):

Uplink ResponseUplink Request

DL

PDU

UL

PDU
???

PDU
???

Illustration 111 The Uplink Simulation DL-PDU

The receiving of the downlink PDU and knowing the corresponding message sequence also allows to 
simulate the associated uplink PDU. The used mobile uplink space directly before or directly after the 
downlink PDU is filled with the uplink message from the known sequence.
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Option ‘Slot Grants’

The second option is that no higher layer downlink message is sent as direct response or as request to an 
uplink message. Only the initial uplink Random-Access Acknowledge and the slot granting is received at the 
downlink. This sequence at the downlink is typical for SDS (Short Data Service) messages without text 
information, like GPS (see 112):

Only slots for sending

DL

RAK
+

Slots

UL

PDU
???

RA
??

Illustration 112 The Uplink Simulation Slot Grants

The request for one half-slot or one full-slot produces a lot of possibilities for uplink PDUs. If the sequence 
starts with a request for two or more full-slots, the probability is increased of being a SDS (Short Data 
Service) message.
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TETRA Uplink Simulation Settings

This chapter provides an overview of the TETRA uplink simulation settings dialogue.

● Open the settings dialogue via ‘Settings’ > ‘TETRA’ > ‘TETRA Uplink Simulation...’.

42f 43f

44f

45f

46f

47f
48f49f50f51f

Illustration 113 MultiAnalyzerQoS: Uplink Simulation Settings Dialogue

No Description

42f Checkbox to activate/deactivate uplink simulation.

43f List with the uplink simulation rules.

44f Button to add a new rule (see chapter TETRA Uplink Simulation Rule Settings).

45f Button to delete the selected rule(s).

46f Button to edit the selected rule (see chapter TETRA Uplink Simulation Rule Settings).

47f Button to reset to factory default. Well known sequences and slot grants rules will be set.

48f Button to apply the changes.

49f Button to quit the settings dialogue without applying the changes.
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No Description

50f
Button to save the settings to a file. For encrypted saving see chapter 7 
MultiAnalyzerSaveRules.

51f Button to load settings from a file.
Table 63 MultiAnalyzerQoS: Uplink Simulation Settings Dialogue
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TETRA Uplink Simulation Rule Settings

This chapter provides an overview of the uplink simulation rule settings dialogue.

● Open the settings dialogue via ‘Settings’ > ‘TETRA’ > ‘TETRA Uplink Simulation... > ‘Add new...’.

Depending on the rule type ‘DL-PDU’ or ‘Slot Grants’, that can be switched by the drop-down list at the top, 
the settings dialogue shows the following available options:

DL-PDU

52f

53f

54f

55f

56f57f

Illustration 114 MultiAnalyzerQoS: Uplink Simulation Rule Settings Dialogue (DL-PDU)

No Description

52f The logical channel where the DL and UL PDU sequence occurs.

53f The higher layer DL PDU that has to be received.

54f
Drop-down list to set the requesting uplink PDU (if the DL PDU is the response to an 
uplink message).

55f
Drop-down list to set the resulting uplink PDU (if the DL PDU is the request for an uplink 
message).

56f Button to use the rule.

57f Button to quit the settings dialogue without using the rule.
Table 64 MultiAnalyzerQoS: Uplink Simulation Rule Settings Dialogue (DL-PDU)
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Slot Grants

58f

59f

60f

61f62f

Illustration 115 MultiAnalyzerQoS: Uplink Simulation Rule Settings Dialogue (Slot Grants)

No Description

58f The logical channel where the slot request occurs.

59f Text field to set the number of full slots that are granted from the base station.

60f Drop-down list to set the requesting uplink PDU.

61f Button to use the rule.

62f Button to quit the settings dialogue without using the rule.
Table 65 MultiAnalyzerQoS: Uplink Simulation Settings Dialogue (Slot Grants)
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5.7.8 Search Dialogue (MultiAnalyzerQoS)

This chapter provides an overview of the search dialogue in MultiAnalyzerQoS.

● Open the search dialogue via ‘Search’ > ‘Find...’ or use the key combination Ctrl+F.

71f 64f

65f66f
67f

68f

69f

70f

Illustration 116 MultiAnalyzerQoS: Search Dialogue

No Description

64f
Checkbox that indicates if the subscriber number is air interface encrypted (ESSI) or not 
(SSI).

65f Button to close the dialogue.

66f Buttons to search backward or forward.

67f
Checkbox to set the search for a cell change event. This is handled as “logical and” with the 
(E)SSI option (e. g. GPS load with the originating/terminating SSI).

68f
Checkbox to set the search for a load type. This is handled as “logical and” with the (E)SSI 
option (e. g. GPS load with the originating/terminating SSI).

69f
Checkbox to set the search for a call type. This is handled as “logical and” with the (E)SSI 
option (e. g. P2P to or from given SSI).

70f
Checkbox to set the search for a wanted subscriber number. If no other type is selected any 
event/load is found with the wanted subscriber associated.

71f
If selected, the search is started on the currently viewed position. Otherwise it starts from 
the beginning or end position.

Table 66 MultiAnalyzerQoS: Search Dialogue
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5.7.9 Python Configuration

This chapter provides an overview of the configuration of the Python interface. With the Python interface, 
you can highlight areas, set markers, change background colors, set borders, play warning tones, etc... in 
real time. The interface also allows you to export data. For real-time display, a script is called each time the 
display changes. The script retrieves the current displayed data, evaluates it and adds information if 
necessary or starts external actions (e.g. playing a sound). For e.g. the manual export of data, there is the 
item "Python Scripts" in the main menu. In the configuration the scripts of the menu can be stored and 
then executed if required.

● Open the settings via 'Settings' > 'Python Scripts...'.

I

llustration 117 MultiAnalyzerQoS: Python Script Configuration

No Description

72f Button to close the window.

73f Path and Python script file that is called for the real-time display.

74f Deletes the selected script file from the Python menu.

75f Adds a new file in Python menu. The path and file name must be specified. The name in the 
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No Description

menu is generated from the file name.

76f List of Python scripts that are created in the menu.

77f Switch to configuration of the Python interpreter.

78f Applies the settings and changes made.

79f Switch to this configuration.
Table 67 MultiAnalyzerQoS: Python Script Configuration

● To access the settings for the Python interpreter select the view "Python Config" (77f):

I

llustration 118 MultiAnalyzerQoS: Python Script Configuration

No Description

80f Button to close the window.

81f Applies the settings and changes made.

82f Switch to this configuration.
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No Description

83f Switch to configuration of the Python script.

84f
With an empty configuration, the system-wide settings for the Python interpreter are used. 
These are defined in the variable "PYTHONHOME". A value overwrites this configuration.

85f Specifies an optional search path where further Python modules can be imported.

86f
Suitable for Python script development purposes. Reloads the script with each call. Changes 
are thus implemented immediately and can be tested.

87f
Suitable for Python script development purposes. Displays the output and error messages 
on a console. The console is open if the program MulitAnalyzerQoS has been started with 
the argument "--debug".

Table 68 MultiAnalyzerQoS: Python Script Configuration
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5.7.10 Starting Real-Time QoS Stream

The QoS data can not only be read from a file, it can also directly received over the IP network. With the 
real-time QoS streaming option, the streamed QoS data can be received and viewed in real-time. The two 
modes Unicast UDP and the Multicast UDP are supported. Both modes can be used with the version IPv4 
or IPv6. With the multicast protocol, an unlimited random number of clients can simultaneously receive the 
QoS data.

To start a real-time QoS stream in MultiAnalyzerQoS, follow the next steps.

1. Open the window to receive the network stream via ‘File’ > ‘Receive network stream...’ or use the 
key combination Ctrl+N.

✔ The streaming address settings dialogue opens (see 119).

Illustration 119 MultiAnalyzerQoS: Receive Network Streaming

 For more information about the streaming address settings dialogue see chapter 5.8.2     Streaming  
Address Settings.

© 2022 femvenner GmbH 132/247



Record and View Protocol Data

2. Enter the required data.

Name IP Address Port

Unicast

UDP
(for IPv4)

The connection interface for receiving UDP data.
For all interfaces use: “0.0.0.0”

The receiving 
port. Use a 
value from 1 
to 65535.

UDP
(for IPv6)

The connection interface for receiving UDP data.
For all interfaces use: “::”

Multicast

MUC
(for IPv4)

The receiving multicast address. Use a value in the IPv4 
multicast range between 224.0.0.0 and 239.255.255.255.

MUC
(for IPv6)

The receiving multicast address. Use a value in the range 
from IPv6: FF00::/8.

3. To choose an adapter, select the checkbox ‘Bind interface’ and click on the button […] (see 120).

Illustration 120 MultiAnalyzerQoS: Bind Interface

NOTICE

Default adapter can be changed by Windows while in use!

If the network adapter is not bound, the default is used. The default adapter can be 
changed by Windows while the adapter is used. Bind the network adapter for multicast 
streaming.
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✔ The dialogue opens to choose a network adapter (see 121).

Illustration 121 MultiAnalyzerQoS: Choose Network 
Adapter

4. Choose a network adapter and click on the button [OK].

✔ The dialogue to choose the network adapter is closed.

5. To start the network stream, click on the button [Ok] (see 122).

Illustration 122 MultiAnalyzerQoS: Start Network Stream

✔ The stream is started.

✔ The receiving process of the data can be watched via the file load information.

6. To watch the receiving process, open the file load information via ‘File’ > ‘File load information’ or 
use the key combination Ctrl+I.

✔ The dialogue opens to read the file information (see 123).

Illustration 123 MultiAnalyzerQoS: File Load Information
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5.7.11 Loading a File (MultiAnalyzerQoS)

There are two modes for loading a record file (*.maf) into the MultiAnalyzerQoS:

● The record is finished

This mode is used by default. For example, if a file is dropped onto the programme or the menu 
option ‘Load Record File..’ is used. The file is loaded until the end. After that the loading process is 
stopped. No further data is refreshed from the record file.

● The record is currently running

This mode is used if the data is loaded via the menu option ‘Load Record Stream...’. The file loading 
never ends, new data is immediately refreshed and can be viewed in real-time.
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5.7.12 Toolbar

The time toolbar shows the current date and time and viewed range of the data. The shown or changed 
values of the toolbar applies to all sub windows. Depending on whether a recorded file is loaded or a record 
stream is running, the toolbar has a different appearance (see 124).

Illustration 124 MultiAnalyzerQoS: Toolbar Time

The following table provides an overview of the available settings:

Icon Description

Drop-down list to set the viewed range. It can be set in steps:
1 minute, 2 minutes, 5 minutes, 10 minutes, 15 minutes, 20 minutes, 30 
minutes and 1 hour.

 The zoom range can also be changed by using the left mouse 
button+mouse wheel.

 
Buttons to move the current viewed time by one step. The step depends on 
the zoom level.

Buttons to freeze or continue the real-time update of the views.


They are only available in the “real-time online view” during a 
record stream (see chapter 5.7.11     Loading a File   
(MultiAnalyzerQoS))

Field that shows the current viewed date and time. It is also possible to directly 
jump to the entered point.

Slider that shows the position within the record data. It is also possible to 
move the position.

 The position can also be changed by using the mouse wheel.

Table 69 MultiAnalyzerQoS: Toolbar Time
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5.7.13 Cells

The data is sorted by cells. Different cells can be loaded at the same time. Every cell owns an own tab page. 
The name of the tab page is the “Location Area” number or if unknown the channel number:

Illustration 125 MultiAnalyzerQoS: Cells

By clicking on the corresponding tab page the currently viewed cell changes.

The coloured icons represent the current receiving status:

Icon Description

Data loading/receiving is completed.

Currently receiving/loading data. No data has been lost.

 Only available in online mode.

No new data has been received for more than 5 seconds.

 Only available in online mode.

Currently receiving data. But in the past there was a gap of more than 5 seconds of 
receiving data.

 Only available in online mode.

 The status can be reset to green ( ) by double-clicking on it.

Currently receiving data. But data has been lost in the past.

 Only available in online mode.

 The status can be reset to green ( ) by double-clicking on it.

Table 70 MultiAnalyzerQoS: Cells
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5.7.14 Presentation of Measuring Results

The different measuring results are presented in sub windows. The list and the view state of the sub 
windows can be found under the menu ‘Windows’ (see chapter 5.7     MultiAnalyzerQoS  ). The single sub 
windows are presented on the following pages.

The content of the windows can be copied or saved with a right-click on the content:

Copy Text Copy Graphic

Copy cell Copy selected cell text. Save...

Save graphic as a picture. The file 
format is determined by the suffix. 
For example, “.png” for PNG pictures 
or “.jpg” for JPEG pictures. The 
supported formats are listed in the 
list of file types within the save 
dialogue.

Copy row
Copy complete row and separates 
different cells with semicolon. 

Copy to 
clipboard

Copy graphic to clipboard.

Copy SSI Try to find SSI information.

Float 
window

Make the current window float.

Close 
window

Close the current window.

Table 71 MultiAnalyzerQoS: Copy Content
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TCH Call Load

The ‘TCH Load’ shows the used channel resources for speech or circuit-mode calls. The load is measured on 
the CCCH channel(s) by the initial call setup and late entry signalling. The view shows the used resources 
over the time. Two groups are shown, yellow for group calls (P2MP) and blue for individual calls (P2P). 
The P2P calls have no late entry information, so the call time has to be assumed for the measurement. 

A double-click on the screen shows the point in time of the closest message to the click in the 
MultiAnalyzerMsc.

• Supported protocols: TETRA and DMR

Illustration 126 MultiAnalyzerQoS: TCH Load
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TCH Call List

The ‘TCH Call List’ shows all occurred calls in the current time range. The starting and ending time of the call 
is displayed in column ‘Time’. The terminating address is displayed in column ‘Address’. The call type 
(P2MP or P2P), the air interface encryption status and if known the initiator of the call is displayed in 
column ‘Comment’. 

The background is filled with the legend colour of the ‘TCH Load’ view that can be set in the menu section 
‘Settings’ (see chapter 5.7     MultiAnalyzerQoS  ). 

A mouse click on the call selects the call in the ‘TCH Load’ display.

• Supported protocols: TETRA and DMR

Illustration 127 MultiAnalyzerQoS: TCH Call List
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TCH Call Summary

The ‘TCH Call Summary’ shows all occurred calls in the current time range. The total call duration is 
displayed in the column ‘Call time’. The number of calls is displayed in the column ‘Number’. The further 
columns split the calls into the occurred call durations.

• Supported protocols: TETRA and DMR

Illustration 128 MultiAnalyzerQoS: TCH Call Summary

© 2022 femvenner GmbH 141/247



Record and View Protocol Data

TCH Slot Usage

The pie chart ‘TCH Slot Usage’ is optimised for the real-time view of the used traffic channels. It shows the 
maximum usage of TCH slots during the last 6 seconds.

• Supported protocols: TETRA and DMR

Illustration 129 MultiAnalyzerQoS: TCH Slot 
Usage
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TCH Capacity Call Usage

This pie chart ‘TCH Capacity Call Usage’ shows the top ten calls. The eleventh item displays a summary of all 
other calls. Hundred percent of the pie chart corresponds to the theoretical speech capacity. The capacity is 
the “viewed time range” multiplied with the “usable TCH slots”. This means all slots of the cell that are not 
used as CCCH slots (MCCH/SCCH). The number of TCH slots are set in the menu section ‘Settings’ (see 
chapter 5.7     MultiAnalyzerQoS  ). 

A mouse click on the call selects the call in the ‘TCH Load’ display.

• Supported protocols: TETRA and DMR.

Illustration 130 MultiAnalyzerQoS: TCH Capacitiy 
Call Usage
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TCH Call Occurred Call Usage

The ‘TCH Occurred Call Usage’ pie chart shows the top ten calls. The eleventh item displays a summery of all 
other calls. Hundred percent of the pie chart corresponds to the used call time and not to the theoretical 
speech capacity. 

A mouse click on the call selects the call in the ‘TCH Load’ display.

• Supported protocols: TETRA and DMR

Illustration 131 MultiAnalyzerQoS: TCH Occurred Call Usage
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TETRA: TCH QoS Load DL/UL

The ‘TCH Load DL’ and ‘TCH Load UL’ show the occurred load on the traffic channel. The single PDUs are 
grouped and displayed into different colours. Depending from current channel state like active speech 
[TCH+SACCH] or no active speech [FACCH] typical load conditions can occur. The signalling depending on 
active traffic channel speech is drawn at the bottom, speech payload (TCH, Uplane, NULL-PDU) is drawn in 
the mid and the SACCH signalling is drawn on the top. The FACCH diagram is likewise a usual MCCH/SCCH. 
The channel states in the DL and UL direction can be independent of each other.

A double-click on the screen shows the point in time of the closest message to the click in the 
MultiAnalyzerMsc.

• Supported protocols: TETRA
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TETRA: TCH QoS Top Instances DL/UL

The ‘TCH Top Instances DL’ and ‘TCH Load UL’  show the top instances that caused load on the traffic 
channel in the current time range. The column ‘Address’ indicates the corresponding mobile or group. The 
downlink column ‘Bits’ represents the total sent bits. The uplink column ‘H.S.’ (Half Slots) represents the 
used half slots. The column ‘Group’ shows the total sent bits per H.S. divided into separate types of 
signalling. The number of PDUs that caused the load are displayed in parentheses.

The background is filled with the legend colour of the most used group from the ‘TCH QoS Load’ view that 
can be set in the menu section ‘Settings’ (see chapter 5.7.3     TCH QoS Load Groups  ).

• Supported protocols: TETRA

llustration 134: MultiAnalyzerQoS: TCH Top 
Instances UL           

llustration 135: MultiAnalyzerQoS: TCH Top 
Instances DL
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TCH Erlang C

These pie charts show the probability that further calls result in queuing for the new subscribers. This value 
is calculated by the following formula:

Number of time slots : c

Total traffic : a=Number of calls∗Average call time
Time

P [W]=

ac

c!
∗ c
c−a

(∑
n=0

c−1
an

n!
)+
ac

c!
∗
c

c−a

The number of time slots (c) describes the possible slots, that are available for speech calls within a cell.
This is normally

(4-number of control channels)+(Further carrier frequencies*4)=Available Slots

In case of an MCCH, an SCCH and another carrier for calls, the result is (4-2)+(1*4)=6. The value must 
correctly be set since it has a big impact on the calculation. The setting is done in the menu section 
‘Settings’ >  ‘TCH Max...’ (see chapter 5.7     MultiAnalyzerQoS  ).

The ‘Number of calls’ is automatically determined from the measurement.

The ‘Time’ depends on the respective pie chart. Normally the general used period is used (applies to 
displays with the heading: ‘period’). The representation corresponds to the average value over this period.

As an alternative, only the data of the last minute of the period can be displayed (applies to displays with 
the heading: ‘last minute’). This display shows recent changes, so it reacts faster to a changed 
swelling/going-down behaviour of calls.

The ‘Average call time’ can automatically be determined from the shown call period. As an alternative, a 
defined value can be assumed (applies to displays with the heading: ‘user’). A defined, e. g. a planning value 
can be compared with the actual measured value. The setting for the defined value is done in the menu 
section ‘Settings’ > ‘TCH Erlang C call length...’ (see chapter 5.7     MultiAnalyzerQoS  ).
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An overview of the Erlang C pie charts:

Name Description

TCH Erlang C
(period)

• Data of the entire displayed time period are used.
• The average call time has been measured.

TCH Erlang C
(period, user)

• Data of the entire displayed time period are used.
• The average call time has been set by the user.

TCH Erlang C
(last minute)

• Data of the last minute are used.
• The average call time has been measured.

TCH Erlang C
(last minute,
user)

• Data of the last minute are used.
• The average call time has been set by the user.
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TETRA: CCCH Load DL/UL and DMR: Channel Load

The ‘MCCH Load’ (or one of the secondary control channels) shows the occurred signalling load on the 
control channel. The single PDUs are grouped and displayed into different colours. Depending on the 
infrastructure and the configuration, different typical idle load conditions can occur (e. g. a high background 
D-NWRK broadcast load). The active load is added on top. 

A double-click on the screen shows the point in time of the closest message to the click in the 
MultiAnalyzerMsc.

• Supported protocols: TETRA and DMR

Illustration 136 MultiAnalyzerQoS: MCCH Load DL

Illustration 137 MultiAnalyzerQoS: MCCH Load UL
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TETRA: CCCH Top Instances DL/UL and DMR: Top Instances

The ‘MCCH Top Instances’ (or one of the secondary control channels) shows the top instances that caused 
load on the control channel in the current time range. The column ‘Address’ indicates the corresponding 
mobile or group. The downlink column ‘Bits’ represents the total sent bits. The uplink column ‘H.S.’ (Half 
Slots) represents the used half slots. The column ‘Group’ shows the total sent bits per H.S. divided into 
separate types of signalling. The number of PDUs that caused the load are displayed in parentheses.

The background is filled with the legend colour of the most used group from the ‘M/SCCH Load’ view that 
can be set in the menu section ‘Settings’ (see chapter 5.7     MultiAnalyzerQoS  ).

• Supported protocols: TETRA and DMR

Illustration 138 MultiAnalyzerQoS: MCCH Top 
Instances DL Illustration 139 MultiAnalyzerQoS: MCCH Top 

Instances UL
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TETRA: CCCH Pie Chart (Load All) DL/UL and DMR: Pie Chart (Load All)

The ‘MCCH Pie Chart (Load All)’ (or one of the secondary control channels) shows the occurred signalling 
load in the current time range in the form of a pie chart. The single PDUs are grouped and displayed into 
different colours. The legend describes the groups and the percentage of the total signalling bandwidth.

• Supported protocols: TETRA and DMR

Illustration 140 MultiAnalyzerQoS: MCCH Pie Chart 
(Load All) DL

Illustration 141 MultiAnalyzerQoS: MCCH Pie Chart 
(Load All) UL
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TETRA: CCCH Pie Chart (Load Usage) DL/UL and DMR: Pie Chart (Load Usage)

The ‘MCCH Pie Chart (Load Usage)’ (or one of the secondary control channels) shows the occurred 
signalling load in the current time range in the form of a pie chart. The single PDUs are grouped and 
displayed into different colours. The legend describes the groups and the percentage of the occurred 
signalling.

• Supported protocols: TETRA and DMR

Illustration 142 MultiAnalyzerQoS: MCCH Pie Chart 
(Load Usage) DL

Illustration 143 MultiAnalyzerQoS: MCCH Pie Chart 
(Load Usage) UL
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User Defined Message Bar

This view shows user-defined messages in the form of a bar chart. One occurrence per second is 
represented by one bar. Up to 10 groups can be defined. Every group can hold up to 128 different messages. 
For every group the colour can be set by double clicking on the legend.

• Supported protocols: TETRA and DMR

Illustration 144 MultiAnalyzerQoS: User Defined Message Bar

In this example the following groups and messages are defined:

Name Description

Speaker in cell
Collection of messages that contain the signalling of a successful call setup that 
was initiated by the originating mobile in the recorded cell:
D-CONNECT (all call types), D-CONNECT-ACK

Call queued
Collection of messages that contain the signalling of a call setup that is queued:
D-CALL PROCEEDING (queued), D-INFO(queued), D-CALL RESTORE(queued)

Release

An initiated call setup is rejected either by SwMI or by the called subscriber. 
For example, the call setup is discontinued or the terminating subscriber is 
busy or unknown…
D-RELEASE on CCCH channel

Table 72 MultiAnalyzerQoS: User Defined Message Bar
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The correlation of the call queued condition and the TCH load can be viewed if the windows ‘TCH Load’ 
and ‘User defined messages’ are viewed combined:

Illustration 145 MultiAnalyzerQoS: Comparison TCH Load and User Defined Message Bar

This view allows conclusions about the mobile user behaviour:

1. Patient user: Once the call queued condition is indicated to the calling user, the user presses and 
holds the PTT (Push-To-Talk) and is connected after the resource becomes available.

2. Impatient user: Once the call queued condition is indicated to the calling user, the user releases the 
PTT and the call is cancelled.

3. Short call queued period: If the time period of the call queued condition is short, the call is 
connected.
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User Defined Message List

This is the corresponding list for the User Defined Message Bar view. To adjust the view, the view has 
additional buttons available:

Button Description

Full list (see 146). The view shows the group and the originator or terminator subscriber identity. 
The number of the messages are displayed in parentheses within the column ‘Group’.
By clicking on the button, the view changes to the summary view.

List summary (see 147). The view shows the group and the originator or terminator subscriber 
identity. The number of the messages are displayed in the column ‘Number’. Additionally the 
time of the first and the last message is displayed.
By clicking on the button, the view changes to the full list view.

Button to show all entries or only the MS that is observed in the cell.

The list only shows entries from the mobile.

The list only shows entries to the mobile.

• Supported protocols: TETRA and DMR

Illustration 146 MultiAnalyzerQoS: User Defined Message (List) -  Full List

Illustration 147 MultiAnalyzerQoS: User Defined Message (List) - Summary
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Record Information

The record information window shows the basic cell data of TETRA or DMR.

Illustration 148 MultiAnalyzerQoS: Record Information
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Stream Information

The ‘Stream Information’ shows information about the packet transfer within a stream in form of a bar 
chart. The number of shown packages can be defined between 5 and 256. For every group the colour can 
be set by double clicking on the legend.
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5.7.15 TETRA Cell Change Basics

The QoS analysis do not only determines the occurring cell changes but also their temporal profile. To 
understand which times are measured, the cell change process has to be understood in detail. There are 
different sections in which a cell change can be split. Depending on which cell change segment is present, 
the segment time is added up on the total time:

Old cell New cellMobile

Speech (clear or E2E)

U-LOCATION UPDATE DEMAND

D-LOCATION UPDATE ACCEPT

U-CALL RESTORE

D-CALL-RESTORE

FACCH

D-AUTHENTICATION DEMAND

U-AUTHENTICATION RESPONSE

D-AUTHENTICATION RESULT

U-AUTHENTICATION RESULT

MCCH

MCCH

U-OTAR PREPARE

D-OTAR NEWCELL

Speech (E2E)

E2E vector

Speech (E2E → unencrypted)

Restore callRoaming into new cellPrepare for cell change Wait for E2E vector

Illustration 149 TETRA Cell Change Basics

• ‘Prepare for cell change’ is the last signalling in the old cell before leaving the cell. It is not mandatory. It 
depends on whether the mobile is involved in a call or an encrypted security class 3 network is used.

• ‘Roaming into new cell’ is the initial signalling in the new cell. An authentication procedure is optionally 
conducted.

• ‘Restore call’ is an optional section when the terminal is involved in a call (listening or speaking).

• ‘Wait for E2E vector’ is an optional section if the ongoing call is E2E encrypted and the terminal is a 
listening party.
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Section Description

Prepare for cell 
change

Before a mobile changes the cell, it may indicate its intention to the SwMI:

Call?No Yes
Undeclared

Radio Link Failure?No Yes
Unannounced

Talking?Yes No

New cell
already known

Call type
P2P P2MP

Announce
Type 3New cell

already known
NoYes

Announced
Type 1+2

Prepare cell
Change

Prepare cell
Change

Unannounced

DCK
forwarding?

No

No action

Yes

Prepare cell
Change

DCK
forwarding?

No

No action

Yes

Prepare cell
Change

NoYes

DCK
forwarding?

No

No action

Yes

Prepare cell
Change

Announced
Type 3

DCK
forwarding?

No

No action

Yes

Prepare cell
Change

No
Unannounced

Yes

Prepare cell
Change

Announced
Type 1+2

YesNo
Unannounced

No action

Radio Link Failure?

No action

No Yes

Illustration 150 Cell Change Flowchart

In case of ‘Prepare cell Change’, signalling is sent from/to the mobile:

Announced DCK forwarding

Mobile

U-PREPARE

D-NEWCELL

Old cell Mobile

U-OTAR PREPARE

D-OTAR NEWCELL

Old cell

Duration measurement

The duration is measured from the starting message ’U-(OTAR) PREPARE’ until the end 
message ‘D-(OTAR) NEW CELL’. The duration includes all repetitions of these messages.

 When a mobile is involved into a call as listening party, this is the starting point 
of the audiophile gap.
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Section Description

Roaming into 
new cell

Depending on whether the location update is performed encrypted or unencrypted, an 
authentication may be additionally performed.

Roaming (unencrypted/encrypted) Roaming with authentication

New cellMobile

U-LOCATION UPDATE DEMAND

D-LOCATION UPDARE ACCEPT

New cellMobile

U-LOCATION UPDATE DEMAND

D-LOCATION UPDATE ACCEPT

D-AUTHENTICATION DEMAND

U-AUTHENTICATION RESPONSE

D-AUTHENTICATION RESULT

U-AUTHENTICATION RESULT

Duration measurement

The duration is measured from the starting message ‘U-LOCATION UPDATE DEMAND’ 
until the end message ‘D-LOCATION ACCEPT’. The duration includes the optional 
authentication and repetition of messages.
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Section Description

Restore call

If a mobile is involved in a call (listening and speaking), the call will be restored after the 
successful ‘Roaming into new cell’:

U-CALL RESTORE

D-CALL-RESTORE

New cellMobile

Duration measurement

The duration of the call restoration increases the time of ‘Roaming into new cell’ 
section.


The time in which the terminal has received no speech and an audible gap 
occurred, is the sum of the time that is required for the roaming and for the 
call restoration.

Section Description

Wait for E2E 
vector

If the conversation is end-to-end encrypted, the terminal has to receipt the next 
encryption initialisation vector for decoding the speech. This leads to an additional 
delay. The speaking terminal of the call does not know when the listening terminal 
changes the cell. Therefore, the encryption initialisation vector is periodically 
transmitted by the talking terminal.

FACCH

Speech (E2E)

U-CALL RESTORE

D-CALL-RESTORE

New cellMobile

E2E vector

Speech (E2E → unencrypted)

Duration measurement

For now this time is not measured.

 The time of waiting for the E2E vector increases the audible gap. The 
audiophile gap stops after receiving the E2E vector.
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5.7.16 Types of Cell Change Measurements

The MultiAnalyzer distinguishes between the following types of cell change:

Name Description

In progress Includes all cells change types that are just performed but not completed yet.

Accept
Includes successful ‘Roaming into new cell’. If the mobile is involved into a call, the 
duration time of the section ‘Restore call’ is included.
If a call restoration is included, the result is printed in the list (accept or fail with reason).

Broken
Includes an unsuccessful ‘Roaming into new cell’. It was started but not finished. This 
means no final message ‘D-LOCATION ACCEPT’ or ‘D-LOCATION REJECT’ was received.

Reject
Includes an unsuccessful ‘Roaming into new cell’. It was started but the SwMI actively 
rejects the mobile with a ‘D-LOCATION UPDATE REJECT’. If known (unencrypted or 
decrypted), the reject reason is printed in the list.

Leaving
Includes all types of the section ‘Prepare for cell change’ and the de-registration of 
mobiles.

Update cmd

If the SwMI is unsure whether a mobile stays on the current cell or not, the SwMI can 
initiate a new registration using the message ‘D-LOCATION UPDATE COMMAND’. If the ‘D-
LOCATION UPDATE COMMAND’ is transmitted unencrypted to an encrypted security class 3 
terminal, the SwMI requests the terminal to renew its DCK. The duration is measured 
from the first message ‘D-LOCATION UPDATE COMMAND’ and includes all repetitions and 
optionally the authentication PDU exchange until the end of the wanted registration 
(similar to the ‘Roaming into new cell’ section).

Table 73 Types of Cell Change Measurement
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Cell Change (TETRA)

The ‘Cell Change’ (TETRA) shows the occurred cell changes over the time:

• Violet bars represent a ‘D-Location Update Command’, that is transmitted by the base station.

• Green bars represent the mobiles that successfully changed to the recorded cell.

• Blue bars indicate the leaving mobiles (undeclared with DCK forwarding, unannounced and 
announced cell reselection).

• Red bars represent the incoming terminals that are rejected by the SwMI or the mutual 
authentication.

• Orange bars represent the broken cell changes.

• Yellow bars represent the cell changes that are in progress and not finished (in online view or at the 
end of the record file).

Repetitions of single messages that are transmitted or received by a terminal are joined into one cell change 
event for that terminal. Each message repetition increases the measured duration time. 

A double-click on the screen shows the point in time of the closest message to the click in the 
MultiAnalyzerMsc.

Illustration 151 MultiAnalyzerQoS: Cell Change (TETRA)
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Cell Change (DMR)

The ‘Cell Change’ (DMR) shows the occurred cell changes over the time:

• Violet bars show a ‘Mass_Reg’ that is transmitted by the trunked station.

• Green bars represent the terminals that successfully changed to the recorded cell 
(C_ACKD[Reg_Accepted]).

 This also can be a successful de-registration.

• Blue bars represent the trunked station command for leaving this channel (Move and Vote_Now).

• Red bars represent the incoming terminals that are rejected by the trunked station.

• Orange bars represent the broken cell changes.

• Yellow bars represent the cell changes that are in progress and not finished (in online view or at the 
end of the record file).

Repetitions of single messages that are transmitted or received by a terminal are joined into one cell change 
event for that terminal. Each message repetition increases the measured duration time. 

A double-click on the screen shows the point in time of the closest message to the click in the 
MultiAnalyzerMsc.

Illustration 152 MultiAnalyzerQoS: Cell Change (DMR)
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Cell Change List

The ‘Cell Change List’ presents all occurred cell changes within the current time range. The column ‘Time’ 
contains the event time, the column ‘Address’ the active mobile. The column ‘Duration’ indicates the 
needed time and the column ‘Comment’ the type of the cell change measurement according to chapter 
5.7.16     Types of Cell Change Measurements  . If known, the cell change type and in case of rejection the 
cause is printed.

The background is filled with the legend colour of the ‘Cell Change’ view that can be set in the menu section 
‘Settings’ (see chapter 5.7     MultiAnalyzerQoS  ).

• Supported protocols: TETRA and DMR

Illustration 153 MultiAnalyzerQoS: Cell Change List
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Top Cell Change List

The ‘Top Cell Change List’ shows the top instances that perform cell changes in the current time range. The 
different cell change types are split and sorted into columns. 

The background is filled with the legend colour of the ‘Cell Change’ view. The number of the displayed 
instances and the legend colour can be defined in the menu section ‘Settings’ (see chapter 5.7 
MultiAnalyzerQoS).

• Supported protocols: TETRA and DMR

Illustration 154 MultiAnalyzerQoS: Top Cell Change List
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How to read and interpret the table ‘Top Cell Change List’?

A mobile avoids cell changes as long as the reception conditions are adequate. When the mobile frequently 
changes the cell, this has several reasons. The reasons can be divided into two different categories:

Completely legitimate reasons:

• The mobile moves frequently from one cell to another.

• The mobile is constantly exposed changing reception conditions. For example, caused by body-damping, 
object-damping, indoor close to a window or near to a wall, the user sits in the car….

Reasons that point to general problems:

• Coverage problems.

• Not optimal broadcast parameters.

• Link budget problems (downlink can be received but the SwMI can not confidently receive uplink).

• Problems with the antenna wiring or the manner how the device is carried.

• Problems with the transmitter, receiver hardware, or external amplifier.

• A jamming source.

• Blocking conditions by a talking device near by the receiving terminal.

• Extreme signalling overload condition on the control channel.

The analysis can not identify what the problem is. However, it can identify the effected mobile subscribers. 
This allows the operator a more detailed analysis:

Problem Description of the Problem Solution

The mobile moves frequently 
from one cell to another

- Ascertain the expected work flow 
for subscriber.

The mobile is constantly exposed 
changing reception conditions

For example, the mobile is at an 
intersection or at a cell boundary 
of two cells. The body-damping or 
object-damping will cause easily 
fast cell changes. Indoor coverage 
conditions fluctuate very fast.

Check to optimise the coverage, 
the broadcast parameter, or 
improve the manner the mobile is 
carried.

Coverage problems Is the time that is needed for cell 
change higher than usual? Are 
there cumulative broken cell 
changes? On encrypted class 3 
networks, is the cell change 

Ascertain the location of the 
subscribers and check the local 
coverage.

Not optimal broadcast 
parameters

Link budget problems
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Problem Description of the Problem Solution

unencrypted or does the mobile 
not initiate DCK forwarding? Are 
other mobile affected at the same 
location?

Problems with the antenna wiring 
or the manner how the device is 
carried

Like the first one but only the 
identified mobile is affected. All 
other mobiles in the area show 
normal behaviour.

Check the hardware and the 
wiring.

Problems with the transmitter or 
receiver hardware or external 
amplifier

A jamming source

Is the behaviour periodical or are 
there some other principles? For 
example the effect occurs at a 
specific time of the day.

Make out the location of the 
subscribers and check the 
spectrum with a spectrum 
analyser.

Blocking conditions

A transmitting terminal (involved 
as transmitting party in a call) may 
block the receiving terminal, if the 
distance between the two 
terminals is small (two colleagues 
are standing close together).

To prevent a blocking condition, 
the two terminals has not to stay 
on the same cell.

Extreme signalling overload 
condition on control channel

Is the control channel load high? Take a look at the control channel 
analysis. In case of a high control 
channel load, enhance the control 
channel resources (add SCCH).
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Cell Change Pie Chart

The ‘Cell Change Pie Chart’ shows the occurred cell change signalling in the current time range in the form 
of a pie chart. The single PDUs are grouped and displayed into different colours. The legend describes the 
events, the percentage and the number of event occurrence in parentheses.

• Supported protocols: TETRA and DMR

Illustration 155 MultiAnalyzerQoS: Cell Change Pie Chart
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Cell Change Pie Chart (Clear/AIE)

The ‘Cell Change Pie Chart (Clear/AIE)’ is similar to the usual ‘Cell Change Pie Chart’ but the types are split 
into unencrypted (clear) and air interface encrypted (AIE) parts. The values in parentheses are the 
occurred PDUs and the total number.

• Supported protocols: TETRA

Illustration 156 MultiAnalyzerQoS: Cell Change Pie Chart (Clear/AIE)
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Cell Change Duration (All)

The ‘Cell Change Duration (All)’ chart shows the duration of the cell change types in the form of a 
histogram. An increment of 500ms is used over a range up to 2 seconds. All values that are above the 2 
seconds appear in the column ‘larger’. The column ‘unknown’ includes all cell changes where the time 
detection was not possible.

• Supported protocol: TETRA

Illustration 157 MultiAnalyzerQoS: Cell Change Duration (All)
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Cell Change Duration (Call Restoration)

The ‘Cell Change Duration (Call Restoration)’ chart shows only the duration of the cell change with call 
restoration in the form of a histogram. An increment of 500ms is used over a range up to 2 seconds. All 
values that are above the 2 seconds appear in the column ‘larger’. The column ‘unknown’ includes all cell 
changes where the time detection was not possible.

• Supported protocol: TETRA

 The measured duration is the audiophile gap that is caused by the current cell (waiting for the 
E2E vector is not included).

Illustration 158 MultiAnalyzerQoS: Cell Change Duration (Call 
Resoration)
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5.8 MultiAnalyzerQosServer

The MultiAnalyzerQosServer reads one or more record files in real-time that are recorded by the 
MultiAnalyzer (see chapter 5.1     MultiAnalyzer  ). The server analyses the data. The resulting high-level QoS 
data is streamed over the IP network in real-time and can be received and viewed by the MultiAnalyzerQoS 
programme (see chapter 5.7     MultiAnalyzerQoS  ). The stream can be sent as unicast to a single client or as 
multicast to an unlimited number of clients (see 159):

MultiCast

Client
Client

Client

Client Client

Server
Server

Client

UniCast

Illustration 159 MultiAnalzyerQosServer: Stream Unicast and Multicast

The IP network hardware provides the sharing of the IP multicast data, e. g. router and switches, so this is 
not a part of the MultiAnalyzer package. In doubt the user may need to configure the support of multicast 
in his network hardware. The IPv4 and IPv6 versions are supported both.

The receiving procedure with the MultiAnalyzerQoS viewer is described in chapter 5.7.10     Starting Real-  
Time QoS Stream. For multicast streaming, the same address for client and server is used.
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5.8.1 Server Interface

This chapter provides an overview of the MultiAnalyzerQosServer interface. Depending on the chosen 
mode, the interface has a different appearance.

Three different setting options are available:

Name Description

Use local QoS settings The local QoS settings are used.

Use stored QoS settings The QoS setting files that were stored in MultiAnalyzerQoS are used. 

Use single file settings The single setting files are used. For this option it can be chosen 
between TETRA DMO and TETRA TMO.
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Use local QoS settings

1g

2g

3g4g

Illustration 160 MultiAnalyzerQosServer: Interface Local Settings

No Description

1g This is the destination address for the streaming data. It is split into three parts:
• The keyword that defines the streaming type, ‘UDP’ for Unicast or ‘MUC’ for Multicast.
• The destination address for streaming IPv4 or IPv6.
• The destination Port with a value between 1 and 65535.

It is not possible to use the same address and port for different streaming files. If the streaming is 
started by the recording MultiAnalyzer, the destination address stays unchanged but the used port 
number is increased by ten until a free port is found.
The button [...] opens the streaming address settings dialogue (see chapter 5.8.2     Streaming   
Address Settings).

2g Information about the streaming files.

3g Button to stop the streaming of the chosen file. The file streaming also stops if the MultiAnalyzer 
recording is stopped.

4g Button to manually start a new streaming. The streaming can also be started from the recording 
MultiAnalyzer and the button [QoS-Stream] (see chapter 5.1.2     Record Settings – Record  ).

Table 74 MultiAnalyzerQosServer: Interface Local Settings
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Use stored QoS settings

5g

6g

Illustration 161 MultiAnalyzerQosServer: Interface Stored Settings

No Description

5g The used AIE configuration file. The button [...] opens the selection dialogue to choose the file.

6g The used QoS settings file. The button […] opens the selection dialogue to choose the file.
Table 75 MultiAnalyzerQosServer: Interface Stored Settings

© 2022 femvenner GmbH 176/247



Record and View Protocol Data

Use single file settings (TETRA DMO)

7g

8g

Illustration 162 MultiAnalyzerQosServer: Interface Single File Settings (TETRA DMO)

No Description

7g Drop-down list to change between the modes TETRA DMO and TETRA TMO.

8g The used CCCH group settings file (see chapter 5.7.2     CCCH QoS Groups  ). Every client uses this 
setting. The file includes groups, names and colours. The button [...] opens the selection dialogue 
to choose the file.

Table 76 MultiAnalyzerQosServer: Interface Single File Settings (TETRA DMO)
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Use single file settings (TETRA TMO)

Illustration 163 MultiAnalyzerQosServer: Interface Single File Settings (TETRA TMO)

No Description

9g The used AIE guess file. The button [...] opens the selection dialogue to choose the file.

10g
The used TCH group settings file (see chapter 5.7.3 TCH QoS Load Groups). Every client uses this 
setting. The file includes groups, names and colours. The button [...] opens the selection dialogue 
to choose the file.

11g
The used file for uplink simulation. The button [...] opens the selection dialogue to choose the file. 
For more information see chapter TETRA Uplink Simulation Settings.

Table 77 MultiAnalyzerQosServer: Interface Single File Settings (TETRA TMO)
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5.8.2 Streaming Address Settings

This chapter provides an overview of the streaming address settings dialogue.

This settings dialogue generates a valid destination streaming address. Depending on the chosen option, the 
result is an unicast or a multicast IPv4 or IPv6 address.

 To start a real-time QoS stream, see chapter 5.7.10     Starting Real-Time QoS Stream  .

Illustration 164 MultiAnalyzerQoSServer: Streaming Address Settings 
Dialogue

Name IP Address

Unicast

UDP
(for IPv4)

The destination IPv4 client address for sending UDP data.
In the format: NNN.NNN.NNN.NNN

UDP
(for IPv6)

The destination IPv6 client address for sending UDP data.
In the format: [NNNN:NNNN:NNNN:NNNN:NNNN:NNNN:NNNN:NNNN]

 Well known short cuts are allowed.

Multicast

MUC
(for IPv4)

The destination IPv4 multicast address. Use a value in the IPv4 multicast range 
from 224.0.0.0 to 239.255.255.255.

 The client uses the same address and port for receiving.

MUC
(for IPv6)

The destination IPv6 multicast address. Use a value in the range from IPv6: 
FF00::/8.

 The client uses the same address and port for receiving.

Table 78 MultiAnalyzerQosServer: Streaming Address Settings
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A red coloured background indicates a problem in the input. A white background indicates that no mistake 
is found. It is needed to set an IP address. Named addresses for unicast are not accepted.

For multicast streaming, the client needs to use the same address as the server. To configure the client, the 
address from line ‘Full address’ can be used.

We recommend for multicast usage, to bind the network adapter. This means the user explicitly choose the 
used network adapter by IP address.

NOTICE

Default adapter can be changed by Windows while in use!

If the network adapter is not bound, the default is used. The default adapter can be 
changed by Windows while the adapter is used. Bind the network adapter for multicast 
streaming.

To bind the network adapter, open the dialogue by selecting the checkbox ‘Bind interface’ and using the 
button […]:

Illustration 165 MultiAnalyzerQosServer: Choose 
Network Adapter


“,BIND=” is added after the address and configures the used network adapter by IP address.
Mainly for Multicast streaming the binding is highly recommended!
Exampe: ,BIND=10.0.128.6 or ,BIND:[2001:0:509c:564e:471:21a2:f5ff:7f95]

© 2022 femvenner GmbH 180/247



MultiAnalyzerSplitter

6 MultiAnalyzerSplitter
Analysing long recordings produces a large amount of data. However, if only the analysis from a certain time 
is desired, this can be disturbed by the other data. Also the sending of such long recordings is cumbersome. 
The separation programme can be used to split recordings into parts or cut out certain points in time, see 
chapter 6.1 Split Files.

Illustration 166: MultiAnalyzerSplitter: Split File

A recording that is divided into several segments can also be reassembled. The sub-segments can be 
created either by splitting with the MultiAnalyzerSplitter or directly when recording with the MultiAnalyzer 
by automatically splitting by time segments. The MultiAnalyzerSplitter offers the possibility to merge these 
separated segments into one file, see chapter 6.2 Merge Files.

Illustration 167: MultiAnalyzerSplitter: Merge File
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6.1 Split Files

After selecting the source recording, the recording is analysed in advance. The start/end time is determined. 
If it is possible, the elapsed time is determined in the protocol.

The file can be split according to three criteria:

• Each segment contains a certain period of time.

• A desired time range is copied.

• A desired number of segments is generated.

Illustration 168 MultiAnalyzerSplitter: Interface Splitting

No Description

1h Text field to set the source file for splitting.

2h
Drop-down list to set the name format for the split files. If the time shall be embedded in 
the name, the embedded time represents the starting time of the file. The time can be local 
or an UTC time stamp.

3h Button to start splitting.

4h This option creates a specified number of files from the source file.

5h This option cuts a specific time range. The start time and the end time are specified.

6h

This option splits the file by time. The time will be expressed in hours and minutes. With the 
additionally activated option ‘Split at the beginning of the time unit’, the file is split when 
the full time is reached. For example, at 01:00 (one hour) every full hour (Start time: 8:15, 
1st split: 9:00, 2nd split: 10:00 etc.). 
Without this option, the file is split every time after one hour has passed (Start time: 8:15, 
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No Description

1st split: 9:15, 2nd split: 10:15 etc.).

7h
This option is only available when the time is sent in the log. If enabled, the timestamp in 
the output files is modified and adjusted to the log time.

Table 79 MultiAnalyzerSplitter: Interface Splitting
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6.2 Merge Files

All files to be merged are selected in the file dialogue or added directly to the list using Drag & Drop. 
Different records are recognized and treated individually. Missing or overlapping time periods are 
highlighted with different colours in the list.

llustration 169: MultiAnalyzerSplitter: Interface Joining

No Description

8h
Each recording owns a random identification number. This distinguishes different records 
from each other. Individual segments of a recording have the same identification number.

9h If there is a gap in the recording between two segments, this gap is highlighted in orange.

10h
If time periods of two segments overlap, the time period of the second file is highlighted in 
yellow.

11h
The list of files to merge. The list is sorted by identification number and start time of the 
segment.

12h Delete all entries from the list.

13h Delete selected entries from the list.

14h
Starts the merge. There must be at least two segments in the list for each recording 
(identification number); each recording asks for the destination file name.

15h Adds one or more files to the list.
Table 80 MultiAnalyzerSplitter: Interface Joining
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7 MultiAnalyzerSaveRules
The MultiAnalyzerSaveRules is a preferences programme to control the allowed save options. Some of the 
configuration data can contain sensitive information. This information can be saved encrypted. A user with 
administrator rights can restrict the allowed save option system-wide.

The following configuration files can be saved encrypted:

• TETRA AIE guess settings

• TETRA uplink simulation

• The general QoS settings (because it contains the settings above)

If one of these settings is saved, a dialogue requests the allowed and possible save options (see chapter 7.2 
Save Options). The possible options are set in the settings (see chapter 7.1     Save Settings  ).
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7.1 Save Settings

The programme needs administrator rights. The settings are valid system-wide. The security to change 
these options depends on the protection of the administrator access. The settings are stored by closing the 
programme.

1i

2i

3i

4i

5i

6i

7i

Illustration 170 MultiAnalyzerSaveRules: Changing Save Options
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No Description

1i

Limit the allowed dongles for encryption. Up to twenty different dongle number ranges 
can be set. The starting and the ending dongle ID is set.
The dongle ID can be read with the programme MultiAnalyzerLicence (see chapter 4.2 
Licence Options):

Every costumer has a reserved dongle ID range of 1000. Every range begins with a full 
thousand range, i.e. 1.000 – 1.999, or 10.000 – 10.999.

2i
Allow to save the settings dongle and password encrypted. A range of dongle IDs (1i) is 
needed for working.

3i
Allow to save the settings dongle or password encrypted. A range of dongle IDs (1i) is 
needed for working.

4i
Allow to save the settings dongle encrypted. A range of dongle IDs (1i) is needed for 
working.

5i Allow to save the settings password encrypted.

6i Allow to save the settings unencrypted.

7i
General enable/disable restrictions. If disabled, unencrypted and password encrypted is 
allowed.

Table 81 MultiAnalyzerSaveRules: Changing Save Options
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7.2 Save Options

If the settings for TETRA AIE, TETRA uplink simulation or the general QoS settings are saved, a dialogue 
opens to request the allowed and possible save options. These options are shown below (see 171) and can 
be set via the save settings (see 7.1     Save Settings  ).

This chapter provides an overview of these possible save options in MultiAnalyzerSaveRules.

Illustration 171 MultiAnalyzerSaveRules: Save Options

Name Description

Save 
unencrypted

The data is saved unencrypted. Everyone can load the data.

Password needed No

Dongle needed No

Save password 
encrypted

The data is saved password encrypted. For decryption, the password is needed.

Password needed Yes (mandatory)

Dongle needed No

Save dongle 
range limited

The data is saved dongle encrypted. For decryption, a dongle with a number 
in a corresponding range is needed.

Password needed No

Dongle needed Yes (mandatory)

Save dongle 
range limited 

or(!) password 
encrypted

The data is saved password or dongle encrypted. For decryption, a dongle 
with a number in a corresponding range is needed, or if not available, the 
password is needed.

Password needed Yes (optionally, if no dongle is present)

Dongle needed Yes (optionally, if Dongle is present no password is needed)

Save dongle 
range limited 

and(!) password 
encrypted

The data is saved password and dongle encrypted. For decryption, a dongle 
with a number in a corresponding range and the password is needed.

Password needed Yes (mandatory)

Dongle needed Yes (mandatory)

Table 82 MultiAnalyzerSaveRules: Save Options
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If an option with a password is selected, the password needs to be set.

 The minimum length of the password is eight characters.

Illustration 172 
MultiAnalyzerSaveRules: Password

 The password is used hashed with “Argon2d” for AES encryption.
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8 MultiAnalyzerNetworkViewer
The MultiAnalyzerNetworkViewer is used to visualise the data of radio towers and the connection between 
the radio towers.

This chapter provides an overview of the MultiAnalzyerNetworkViewer interface and menus.

1j

2j 3j 4j

5j

6j

7j8j

9j

Illustration 173 MultiAnalyzerNetworkViewer: Interface
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No Description

1j The toolbar ‘Load and Save’ (see chapter 8.1     Toolbars  ).

2j The menu bar.

3j Basics toolbar to change e. g. the graph style and mode (see chapter 8.1     Toolbars  ).

4j Geographical tools (see chapter 8.1     Toolbars  ).

5j

The docking window ‘Scale’ shows e .g. the current zoom level and scale factor when a 
graph is drawn in geographic style (see chapter 8.3     Docking Windows  ).

 This docking window presents its information only if a graph is drawn in 
the geographic style.

6j
The docking window ‘Symbols’ shows the towers and marks (see chapter 8.3     Docking   
Windows).

7j The docking window ‘Tower Information’ shows the information of towers and marks.

8j
The docking window ‘Draw Area’ shows the drawn graph (see chapter 8.3     Docking   
Windows).

9j
The docking window ‘Data List’ shows e. g. the tower list, mark list and overlay list (see 
chapter 8.3     Docking Windows  ).

Table 83 MultiAnalyzerNetworkViewer: Interface

© 2022 femvenner GmbH 191/247



MultiAnalyzerNetworkViewer

Menu ‘File’

Illustration 174 
MultiAnalyzerNetworkViewer: Menu 
‘File’

Name Key Combination Description

Open File... Ctrl+O Open a CSV file, record file, or overlay file.

Open Record file none
Open a record file.

 Only available if a CSV file is loaded.

Open Overlay file none Open an overlay file.

Save Ctrl+S Save the data from the programme to a CSV file.

Export to Image... none Export the current view to an image.

Close Data none Close the current data.

Close Ctrl+F4 Close the programme.
Table 84 MultiAnalyzerNetworkViewer: Menu ‘File’
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Menu ‘Tools’

Illustration 175 
MultiAnalyzerNetworkViewer: Menu  
‘Tools’

Name Description

Zoom In

Increase the zoom level by one level.

 Only available if a geographic graph is drawn and the zoom 
level can be increased by one.

Optimal Zoom
Zoom to the optimal zoom level.

 Only available if a geographic graph is drawn.

Zoom Out

Decrease the zoom level by one level.

 Only available if a geographic graph is drawn and the zoom 
level can be decreased by one.

Centre on Own Position

Centre the map on the tracked GPS position.

 Only available if a geographic graph is drawn and the GPS 
tracking is activated.

Load Map
Load the tiles of a map to the cache.

 Only available if downloading is allowed.

Table 85 MultiAnalyzerNetworkViewer: Menu ‘Tools’
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Menu ‘Settings’

Illustration 176 
MultiAnalyzerNetworkVi
ewer: Menu ‘Settings’

Name Description

Colour

Change the colours of the 
tower status.
Edit: Open colour selection 
dialogue, to edit the colour.
Reset: Set back to factory 
default.
Cancel: Close settings dialogue 
without applying the changes.
Ok: Apply the changes.

Settings Change the settings (see chapter 8.2     Settings  ).

Save Settings Save the settings to a file.

Load Settings Load the settings from a file.
Table 86 MultiAnalyzerNetworkViewer: Menu ‘Settings’
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Menu ‘Windows’

Illustration 177 
MultiAnalyzerNetworkViewer
: Menu ‘Windows’

Name Description

Data List
Show or hide the docking window that contains the loaded data. (see 
chapter 8.3     Docking Windows  ).

Symbols
Show or hide the docking window that contains the symbols (see chapter 
8.3     Docking Windows  ).

Scale
Show or hide the docking window that contains the information about the 
scale and the map (see chapter 8.3     Docking Windows  ).

Tower Information
Show or hide the docking window that contains the information about the 
tower (see chapter 8.3     Docking Windows  ).

Draw Area
Show or hide the docking window that contains the area to draw the graph 
(see chapter 8.3     Docking Windows  ).

Load and Save
Show or hide the toolbar that contains the tools for loading and saving the 
data (see chapter 8.1     Toolbars  ).

Basic Tools
Show or hide the toolbar that contains the basic tools (see chapter 8.1 
Toolbars).

Overlay Tools
Show or hide the toolbar that contains the tools for the overlay (see 
chapter 8.1     Toolbars  ).

Geographical Tools
Show or hide the toolbar that contains the graphical tools (see chapter 8.1 
Toolbars).

Table 87 MultiAnalyzerNetworkViewer: Menu ‘Windows’
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Menu ‘Help’

Illustration 178 MultiAnalyzerNetworkViewer: 
Menu ‘Help’

Name Description

About Qt... Show information about Qt.

About MultiAnalyzerNetworkViewer... Show information about MultiAnalyzerNetworkViewer.
Table 88 MultiAnalyzerNetworkViewer: Menu ‘Help’
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8.1 Toolbars

This chapter provides an overview of the different toolbars in MultiAnalyzerNetworkViewer.

Load and Save

Illustration 179 
MultiAnalyzerNetwork
Viewer: Load and Save

Icon Description

Button to open a CSV file, record file, or overlay file.

Button to save the data from the programme to a CSV file.

 Only available if data is loaded.

Button to export the view of the Draw Area to an image.

 Only available if a graph is drawn in the Draw Area.

Table 89 MultiAnalyzerNetworkViewer: Load and Save
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Basic Tools

Illustration 180 MultiAnalyzerNetworkViewer: Basic Tools

Icon Description

Drop-down list to change the graph style between ‘geographic’ and 
‘circle’ (see chapter 8.5     Graph Styles  ).

Drop-down list to change the geographic graph mode between ‘default’, 
‘show all’ and ‘Range in km’ (see chapter 8.5     Graph Styles  ).

 Only available if the graph style is set to ‘geographic’.

Drop-down list to change the visibility range of the graph.

 Only available if the graph style is set to ‘geographic’ and 
the geographic mode is set to ‘Range in km’.

Checkbox to activate or deactivate the tracking of the GPS positions.

 Only available if the graph style is set to ‘geographic’.

Checkbox to activate or deactivate ‘Compare Carrier to all’. The carriers 
by default are only compared to their direct neighbour carriers.

Button to make all hidden elements visible.

Table 90 MultiAnalyzerNetworkViewer: Basic Tools
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Overlay Tools

Illustration 181 MultiAnalyzerNetworkViewer: Overlay 
Tools

Icon Description

Slider to change the transparency of the overlays.

 Only available if an overlay file is loaded.

Table 91 MultiAnalyzerNetworkViewer: Overlay Tools

Geographical Tools

Illustration 182 
MultiAnalyzerNetworkViewer: 
Geographical Tools

Icon Description

Button to increase the zoom level by one level.

 Only available if a geographic graph is drawn and the zoom 
level can be increased by one level.

Button to zoom to the optimal zoom level.

 Only available if a geographic graph is drawn.

Button to decrease the zoom level by one level.

 Only available if a geographic graph is drawn and the zoom 
level can be decreased by one level.

Button to centre the map on the tracked GPS position.

 Only available if a geographic graph is drawn and the GPS 
tracking is activated.

Button to load the tiles of a map to the cache.

 Only available if downloading is allowed.

Table 92 MultiAnalyzerNetworkViewer: Geographical Tools
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8.2 Settings

This chapter provides an overview of the MultiAnalzyerNetworkViewer settings dialogue.

10j

11j

12j

13j

14j

15j

16j17j18j19j

Illustration 183 MultiAnalyzerNetworkViewer: Settings Dialogue

No Description

10j
Checkbox to activate and deactivate the possibility to download the map from the internet. 
If it is deselected, the map is only loaded from the local cache (13j).

11j Text field to set the server address of the map server.

12j

Text field to set the pixel size of a single tile of the map.


The Tile Size is a server-specific parameter and specifies the size of a tile in pixel 
(e. g. 256 means one tile consists of 256x256 pixel).

13j
Text field to set the path to the local map cache. In this folder, the downloaded tiles of the 
map are saved. The tiles for the map are primarily loaded from the cache.
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No Description



The programme automatically stores the map tiles, which are used for zooming and 
scrolling in the geographic view, in this cache.

There is no need to download the map tiles again and it is possible to offline work 
with maps.

14j

The minimum and maximum zoom level that are allowed to zoom in or out.


Reducing the amount of map data to be downloaded from a server can be 
achieved by restricting the Zoom Level Range.

15j Text field to set the COM port where a GPS mouse is connected.

16j Text field to set the baud rate of the GPS mouse.

17j Button to close the window without saving the settings.

18j Button to close the window and save the settings.

19l Button to reset the settings to default.
Table 93 MultiAnalyzerNetworkViewer: Settings
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8.3 Docking Windows

This chapter provides an overview of the different docking windows in MultiAnalyzerNetworkViewer.

Scale

20j 21j

22j

23j

Illustration 184 MultiAnalyzerNetworkViewer: 
Scale

No Description

20j
The scale factor shows the factor of the distance of 1 centimetre on the monitor compared 
to the real distance.

21j The zoom level shows the current zoom level of the drawn graph.

22j The scale shows an example of the distance.

23j The copyright information shows the source of the map data.
Table 94 MultiAnalyzerNetworkViewer: Scale
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Symbols

24j25j

Illustration 185 MultiAnalyzerNetworkViewer: 
Symbols

No Description

24j
This section shows the definitions of all colours that are used by the towers in the graph.
To change the colours of the towers, see chapter 8     MultiAnalyzerNetworkViewer   menu 
section ‘Settings’.

25j This section shows all created or loaded marks including their colours.
Table 95 MultiAnalyzerNetworkViewer: Symbols
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Draw Area

26j

27j

28j

29j 30j

Illustration 186 MultiAnalyzerNetworkViewer: Draw Area

No Description

26j

Button to decrease the zoom level by one level.

 Only available if a geographic graph is drawn and the zoom level can be decreased 
by one.

27j
Button to zoom to the optimal zoom level.

 Only available if a geographic graph is drawn.

28j

Button to increase the zoom level by one level.

 Only available if a geographic graph is drawn and the zoom level can be increased 
by one.

29j
Button to load the tiles of a map to the cache.

 Only available if a geographic graph is drawn and downloading is allowed.

30j The area where the graph is drawn.
Table 96 MultiAnalyzerNetworkViewer: Draw Area
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The Draw Area has the following key bindings available:

Function Key Combination Description

Zoom in Page Up Increases the zoom level by one level.

Zoom out Page Down Decreases the zoom level by one level.

Zoom to Default Home/Pos 1 Changes the zoom level to the default zoom level.

Move Map up Arrow Up Moves upward within the map.

Move Map down Arrow Down Moves downward within the map.

Move Map left Arrow Left Moves to the left within the map.

Move Map right Arrow Right Moves to the right within the map.

Highlight Cell Space Highlights a cell on the map.

Select Highlighted Cell Return/Enter Selects the highlighted cell.
Table 97 MultiAnalyzerNetworkViewer: Draw Area Keybindings
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Data List

31j

32j

33j

34j

35j

36j37j38j

Illustration 187 MultiAnalyzerNetworkViewer: Data List
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No Description

31j

Drop-down list to filter the elements in the list.
The options are:

• all
• drawn
• not drawn
• connected
• indirect connected

32j The tower list shows the towers and their visibility status.

33j The mark list shows the marks and their visibility status.

34j The overlay list shows the loaded overlay files.

35j Search bar to search for elements from the list. The first found element will be highlighted.

36j
Button to delete an element in the list (see chapter 8.13     Deleting a Data List Element  ).

 Only available if a tower or a mark from the list is selected.

37j

Button to edit an element in the list (see chapter 8.11     Editing the Tower Information   and 
8.12     Editing the Mark Information  ).

 Only available if a tower or a mark from the list is selected.

38j
Button to create a mark (see chapter 8.9     Creating a Mark (Pop-Up Menu)   and 8.10     Creating   
a Mark (Data List)).

Table 98 MultiAnalyzerNetworkViewer: Data List

 Graph elements will be drawn, if they have an “eye” icon.
Graph elements will not be drawn, if they have a “crossed eye” icon.
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8.4 Loading a File (MultiAnalyzerNetworkViewer)

It is possible to load CSV files, record files (e. g. *.maf, *.tmw), or overlay files. Already loaded CSV files can 
be extended by additionally loading a record file.

 If incomplete recorded data is loaded, the programme opens a dialogue to fill in the missing 
information (see chapter 8.4.2     The Data of a Record File  ).

 For information about saving the data, see chapter 8.6     Saving Data  .

To load a file into the MultiAnalyzerNetworkViewer, follow the next steps.

1. Open the selection dialogue to choose a file via ‘File’ > ‘Open File...’ or use the key combination 
Ctrl+O.

✔ The selection dialogue opens (see 188).

 By default the selection dialogue shows only CSV files.

Illustration 188 MultiAnalyzerNetworkViewer: Open File



The files that to be shown can be changed via the drop-down list:
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2. To open the file, choose the file and click on the button [Open].

 Overlay files are directly loaded into the programme.

✔ MultiAnalyzerNetworkViewer shows the following dialogue:

Illustration 189 
MultiAnalyzerNetworkViewer: 
Loading Succeed

✔ The file is loaded into the MultiAnalyzerNetworkViewer.

 If the programme is not able to automatically load the file, see chapter 8.4.1     Data Order   
Dialogue.

 For information about the different graph styles to present the data, see chapter 8.5     Graph   
Styles).
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8.4.1 Data Order Dialogue

If a CSV file is loaded and the programme is not able to automatically load the file, the programme opens a 
dialogue to define the order of the CSV file.

This chapter provides an overview of the dialogue to order the data in MultiAnalyzerNetworkViewer.

39j

40j

41j

42j

43j

44j

45j

46j

47j48j

49j

50j

Illustration 190 MultiAnalyzerNetworkViewer: Data Order

© 2022 femvenner GmbH 210/247



MultiAnalyzerNetworkViewer

No Description

39j Drop-down list to select an order.

40j Button to delete the selected order.

41j

The selected order of data types. The entries can be moved right/left between the lists and 
up/down within the right list.

 The entries on the list are associated with the columns of the CSV file (the entry 
on the top represents the first column of the file).

42j
Buttons to move an entry between the two lists (50j and 41j) or to move the entry up and 
down within list 41j.

43j

Buttons to add an entry to the left list or to delete an entry from the left list (see chapter 
Adding an Entry and Deleting an Entry). The column name is to be specified in the field 
(49j).

 It is neither possible to add a name that already exists nor to add an entry 
without a name.



The following entries can not be deleted from the list:
• Ignore
• MCC
• MNC

• LAC
• Longitude
• Latitude

• Carrier
• Neighbour
• Name

 The entry ‘Ignore’ is used for an entry that is unknown by the programme and 
can be used in the right list multiple times.

44j
Drop-down list to specify the separator between the columns.
The separator can be a comma, a semicolon, a hash, a blank, or a tab.

45j
Drop-down list to specify the separator between the values in a column if there are more 
than one value included in a column (see 190, column ‘Name’).
The separator can be a comma, a semicolon, a hash, a blank, or a tab.

46j

A preview of the loaded data. The data in the CSV file is displayed as follows:

Illustration 191 MultiAnalyzerNetworkViewer: Example CSV File

47j Button to close the window without applying the changes.

48j Button to close the window and apply the changes.
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No Description



If a new order was built, a new dialogue opens to set the name of the new 
preset.

49j
Text field to add an entry for an individual column.

 A new column can only be added if the entry is not already present in the left list.

50j

All available entries. New added entries are first listed here. The entries can be moved 
between the right and left list.

 It is only possible to delete an entry if the entry is located in this list.

Table 99 MultiAnalyzerNetworkViewer: Data Order
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Adding an Entry

If the CSV file contains more columns than predefined entries exist, a new entry can be added to the list. 

 The entries on the list are associated with the columns of the CSV file (the entry on the top 
represents the first column of the file).

To add a new entry to the order list, follow the next steps.

1. Enter a name into the field (see 192).

 It is neither possible to add a name that already exists nor to add an entry without a name.

Illustration 192 MutliAnalyzerNetworkViewer: New Column Name

2. To add the new entry, click on the button [Add] (see 193).

Illustration 193 MultiAnalyzerNetworkViewer: Add New Entry
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✔ The new entry is added to the left list (see 194).

Illustration 194 MultiAnalyzerNetworkViewer: New Entry 
Added

 To move an entry, see chapter Moving an Entry.

 To delete an entry, see chapter Deleting an Entry.
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Moving an Entry

The entries can be moved between the lists. It is also possible to change the order of the columns within 
the right list.

 The entries on the list are associated with the columns of the CSV file (the entry on the top 
represents the first column of the file).



The following entries can not be moved between the lists:
• MCC
• MNC
• LAC

• Longitude
• Latitude
• Carrier

• Neighbour
• Name

To move the entries within the lists, follow the next steps.

➔ The lists contain new added entries or entries that can be moved between the lists.

 To add an entry, see chapter Adding an Entry.

1. To move an entry from the left list to the right list, select the wanted entry and click on the right 
arrow button (see 195).

Illustration 195 MultiAnalyzerNetworkViewer: Move Entry
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✔ The selected entry is moved to the right list (see 196).

Illustration 196 MultiAnalyzerNetworkViewer: 
Entry Moved

2. To arrange the order of the right list, select the wanted entry and use the up/down arrow buttons 
(see 197).

Illustration 197 MultiAnalyzerNetworkViewer: Entry 
Order
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✔ The order of the entries is changed (see 198).

Illustration 198 MultiAnalyzerNetworkViewer: New 
Order

 To delete an entry, see chapter Deleting an Entry.
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Deleting an Entry

It is possible to delete not needed entries from the list.

 The entries on the list are associated with the columns of the CSV file (the entry on the top 
represents the first column of the file).



The following entries can not be deleted from the list:
• MCC
• MNC
• LAC

• Longitude
• Latitude
• Carrier

• Neighbour
• Name

To delete an entry, follow the next steps.

➔ The entries that shall be deleted are located in the left list.

 To move an entry, see chapter Moving an Entry.

1. Select an entry from the left list that shall be deleted (see 199).

Illustration 199 MultiAnalyzerNetworkViewer: 
Selected Entry
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1. To delete the selected entry, click on the button [Delete] (see 200).

Illustration 200 MultiAnalyzerNetworkViewer: Delete Entry

✔ The entry is deleted (see 201).

Illustration 201 MultiAnalyzerNetworkViewer: Entry Deleted

 To add an entry, see chapter Adding an Entry.
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8.4.2 The Data of a Record File

If a record file with incomplete data is loaded, a dialogue opens to complete the missing information.

This chapter provides an overview of the dialogue to complete the data of a record file.

51j

52j

53j

54j

55j56j57j

Illustration 202 MultiAnalyzerNetworkViewer: Incomplete Data Record File
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No Description

51j
The ‘LAI’ of the tower. The ‘LAI’ consists of the mobile country code, mobile network 
code, and the local area code.

52j
The name of the selected cell. 

 The text field can be used to change the name of the cell.

53j
The longitude position of the selected tower cell. 

 The field can be used to change the longitude of the tower cell.

54j
The latitude position of the selected tower cell. 

 The field can be used to change the latitude of the tower cell.

55j The list of incomplete towers. Each tower in this list has at least one missing information.

56j Button to close the window without applying the changes.

57j Button to close the window, apply the changes and update the view.
Table 100 MultiAnalyzerNetworkViewer: Incomplete Data Record File


By selecting a tower, the available information are filled into the fields ‘LAI’ (51j), ‘Name’ (52j), 
‘Longitude’ (53j), and ‘Latitude’ (54j). Changes to these information are directly visible in the 
list.

 It is also possible to change these information after the file has already been loaded (see 
chapter 8.11     Editing the Tower Information  ).
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8.5 Graph Styles

The graph can be displayed in two styles. The first style builds up on the coordinates of the towers and the 
second style shows the graph in a circle. The ‘geographic’ style is set by default. Both graphs are build from 
the same data.

The styles can be changed by using the drop-down list (see 203).

Illustration 203 MultiAnalyzerNetworkViewer: Available Graph Styles

Geographic

The geographic graph style builds up the coordinates of the tower cells.

Illustration 204 
MultiAnalyzerNetworkViewer: Graph 
Geographical Style

 To export the graph to an image, see chapter 8.7     Exporting a Graph to an Image  .
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The geographic style has three different modes available to build the graph (see 205).

Illustration 205 MultiAnalyzerNetworkViewer: Geographic Style Modes

default

This mode displays all elements of the area between the highest and the lowest 
longitude and latitude.

 This mode is also used to select the elements for the graph style ‘circle’.

show all This mode displays all tower cells that are contained in the loaded data.

Range in km
This mode displays all elements that are located within the radius (km) around the 
selected element. The radius can be set to 5, 10, 25, 50, or 100.

Table 101 MultiAnalyzerNetworkViewer: Geographic Style Modes
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Circle

The circle graph style is a model view of the map to show the base stations and their neighbours.

 Marks are not drawn in this style.

Illustration 206 MultiAnalyzerNetworkViewer: Graph 
Circle Style

 To export the graph to an image, see chapter 8.7     Exporting a Graph to an Image  .
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8.6 Saving Data

Data that are loaded into the MultiAnalyzerNetworkViewer can be saved as a CSV file. The save function 
can also be used to combine CSV data and record data. For that a CSV file and a record file has to be loaded 
to the MultiAnalyzerNetworkViewer.


For information about loading data, see chapter 8.4     Loading a File   
(MultiAnalyzerNetworkViewer).

To save the data as a CSV file, follow the next steps.

➔ Data is loaded into the MultiAnalyzerNetworkViewer.

 The elements to save the data are only available if the programme has data to save.

1. Open the dialogue to save the data via ‘File’ > ‘Save’ or use the key combination Ctrl+S.


It is also possible to use the button in the toolbar:

✔ The save dialogue opens to save the data file (see 207).

Illustration 207 MultiAnalyzerNetworkViewer: Saving Data

2. To save the data file, choose the storage path and click on the button [Save].

 If an existing file is chosen, the data of the existing file will be overwritten.

✔ The data file is saved.
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8.7 Exporting a Graph to an Image

The shown graph can be saved to an image file (*.jpg or *.png). 

To save the graph to an image file, follow the next steps.

➔ A graph is drawn in the Draw Area.

 The elements to export a graph to an image are only available if a graph is drawn.

1. Open the dialogue to save the graph into an image file via ‘File’ > ‘Export to Image’.


It is also possible to use the button in the toolbar:

 For information about the different graph styles, see chapter 8.5     Graph Styles  .

✔ The save dialogue opens (see 208).

Illustration 208 MultiAnalyzerNetworkViewer: Export to Image

2. To save the image file, choose the storage path and click on the button [Save].

 If an existing file is chosen, the data of the existing file will be overwritten.

✔ The image file is saved.
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8.8 Loading a Map

For a geographical display of the data, map data can be downloaded in tiles. Generating the tiles for maps 
consume much resources of a server.

NOTICE

Massive downloading can cause ban from server!

The consequences of massive downloading of tiles could be a ban for downloading from 
the server. Download only as much as needed.


Reducing the amount of map data to be downloaded from a server can be achieved by 
restricting the ‘Zoom Level Range’ (see chapter 8.2     Settings  ).

The raw map data is open source and free to use. So, it is possible to build an own local server to generate 
tiles from the raw map data. A few companies sell access to their map servers for more heavier use.

This chapter provides an overview of loading a map into the MultiAnalyzerNetworkViewer.

● Open the dialogue to load a map via ‘Tools’ > ‘Load Map’.



It is also possible to use the button in the toolbar or the button within the Draw Area:


The elements to download a map are only available if the setting ‘Download allowed’ is activated 
(see chapter 8.2     Settings  ).


The downloaded data are saved to the path for the ‘Local Map Cache’, which is set in the 
‘Settings’ (see chapter 8.2     Settings  ). Existing data will be overwritten.
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 If a graph is drawn, the dialogue is preset with the data of the graph.

63j 62j 61j

60j

59j

58j

Illustration 209 MultiAnalyzerNetworkViewer: Load Map

No Description

58j

Drop-down list to select one of the defined presets.
There are 16 presets for the federal states of Germany.

 If data are changed, the preset changes to “custom”.

59j The longitude range that the downloaded map should contain.

60j The latitude range that the downloaded map should contain.

61j Drop-down list to set the zoom level of the map section.

62j Button to close the dialogue and start downloading the map data.

63j Button to close the dialogue without downloading.
Table 102 MultiAnalyzerNetworkViewer: Load Map
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8.9 Creating a Mark (Pop-Up Menu)

Marks can directly be created within the Draw Area via the pop-up menu. When creating a mark via the 
pop-up menu, the longitude and latitude data is directly copied into the mark information dialogue from 
the position of the mouse click.

To create a mark via the pop-up menu, follow the next steps.

➔ Data are loaded into MultiAnalyzerNetworkViewer (see chapter 8.4     Loading a File   
(MultiAnalyzerNetworkViewer)).

➔ A geographic graph is drawn (see chapter 8.5     Graph Styles  ).

1. To open the pop-up menu, right-click on the wanted position on the drawn graph.

✔ The pop-up menu opens (see 210).

Illustration 210 MultiAnalyzerNetworkViewer:  
Mark Pop-Up Menu
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2. To open the mark information dialogue, click on the menu option ‘Create Mark’ (see 211).

Illustration 211 
MultiAnalyzerNetworkViewer: Menu Option 
Create Mark

✔ The mark information dialogue opens (see 212).

 The data for longitude and latitude is taken from the position of the click on the map.

Illustration 212 
MultiAnalyzerNetworkViewer: 
Mark Info

 The data of the longitude and latitude can be changed by using the text fields.

 The colours of the background, the border, and the text of the mark can be changed via the 
button [Edit Colours].
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3. To create the mark on this position, insert a name into the empty field and click on the button [OK] 
(see 213).

Illustration 213 
MultiAnalyzerNetworkViewer: 
Mark Test (Pop-Up)

✔ The mark is created.

 It is also possible to change the data of the mark afterwards (see chapter 8.12     Editing the Mark   
Information).

✔ The mark is shown on the Draw Area and on the Data List (see 214).

Illustration 214 MultiAnalyzerNetworkViewer: Mark Draw Area and Data 
List (Pop-Up)
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8.10 Creating a Mark (Data List)

Marks can be created at any time via the Data List whether or not data is loaded into the 
MultiAnalyzerNetworkViewer.

To create a mark using the Data List, follow the next steps.

1. To open the mark information dialogue, click on the button [Create Mark] on the Data List (see 215).

Illustration 215 MultiAnalyzerNetworkViewer: 
Create Mark Data List

✔ The mark information dialogue opens (see 216).

Illustration 216 
MultiAnalyzerNetworkViewer: 
Empty Mark

 The colours of the background, the border, and the text of the mark can be changed via the 
button [Edit Colours].
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2. Fill in the information for the longitude and latitude into the dedicated fields (see 217).

Illustration 217 
MultiAnalyzerNetworkViewer: 
Enter Info

3. To create the mark, insert a name into the empty text field and click on the button [OK] (see 218).

Illustration 218 
MultiAnalyzerNetworkViewer: 
Mark Test (Data List)

✔ The mark is created.

 The data of the mark can also be changed afterwards (see chapter 8.12     Editing the Mark   
Information).

✔ The mark is shown on the Data List and if a graph is drawn, it is also shown on the Draw Area (see 
219).

Illustration 219 MultiAnalyzerNetworkViewer: Mark Draw Area and Data 
List (Data List)
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8.11 Editing the Tower Information

The information of the towers (name, longitude and latitude) can be edited at any time.

To edit the tower information, follow the next steps.

➔ Data are loaded into MultiAnalyzerNetworkViewer (see chapter 8.4     Loading a File   
(MultiAnalyzerNetworkViewer)).

1. To open the tower information dialogue, select a tower from the Data List and click on the button 
[Edit] (see 220).

Illustration 220 MultiAnalyzerNetworkViewer: 
Tower Data List


The information dialogue can also be opened by right-clicking on a tower that is located in the 
Draw Area and choosing the menu option ‘Edit Tower’ or by double-clicking on the Data List 
area.

© 2022 femvenner GmbH 234/247



MultiAnalyzerNetworkViewer

✔ The tower information dialogue opens (see 221).

Illustration 221 MultiAnalyzerNetworkViewer: Dialogue Edit Tower

2. Choose the tower that shall be changed and fill in the information (see 222).

Illustration 222 MultiAnalyzerNetworkViewer: Dialogue Edit Tower (Selected Tower)

 For information about the interface, see chapter 8.4.2     The Data of a Record File  .

3. To save the changes, click on the button [OK].

✔ The changes are saved and the list is updated.
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8.12 Editing the Mark Information

The information of the created marks (name, longitude and latitude) can be edited at any time.

To edit the mark information, follow the next steps.

➔ A mark has already been created (see chapter 8.9     Creating a Mark (Pop-Up Menu)   and 8.10     Creating  
a Mark (Data List)).

1. To open the mark information dialogue, select a mark from the Data List and click on the button 
[Edit] (see 223).

Illustration 223 MultiAnalyzerNetworkViewer: 
Mark Data List


The information dialogue can also be opened by right-clicking on a mark that is located in the 
Draw Area and choosing the menu option ‘Edit Mark’ or by double-clicking on the Mark within 
the Data List.

✔ The mark information dialogue opens (see 224).

Illustration 224 
MultiAnalyzerNetworkViewer: 
Dialogue Edit Mark
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2. Change the wanted information and click on the button [OK].

✔ The information is changed (see 225).

Illustration 225 
MultiAnalyzerNetworkViewer: 
Dialogue Mark Edited
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8.13 Deleting a Data List Element

Elements can be deleted from the Data List.

 For information about hiding and unhding an element, see chapter 8.14     Hiding and Unhiding an   
Element.

To delete an element from the Data List, follow the next steps.

➔ Deletable elements are available in the Data List.

● To delete an element, select an element that shall be deleted from the Data List and click on the 
button [Delete] (see 226).

 An element can also be deleted by right-clicking on an element that is located in the Draw Area 
and choosing the menu option ‘Delete’.

Illustration 226 MultiAnalyzerNetworkViewer: 
Delete Element
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✔ The element is deleted from the list (see 227).

Illustration 227 MultiAnalyzerNetworkViewer: 
Deleted Element
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8.14 Hiding and Unhiding an Element

Elements can be hidden via the pop-up menu. The elements are still available in the Data List and can be 
made visible again.

 For information about deleting an element, see chapter 8.13     Deleting a Data List Element  .

To hide and unhide an element, follow the next steps.

➔ Data are loaded into MultiAnalzyerNetworkViewer.

➔ A geographic graph is drawn in the Draw Area (see chapter 8.5     Graph Styles  ).

1. Choose the element that shall be hidden from the Draw Area.

2. To open the pop-up menu, right-click on the chosen element.

✔ The pop-up menu opens (see 228).

Illustration 228 MultiAnalyzerNetworkViewer: 
Hiding Pop-Up Menu
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3. Click on the menu option ‘Hide’ (see 229).

Illustration 229 
MultiAnalyzerNetworkViewer: Menu Option 
Hide

✔ The element is hidden on the Draw Area and the eye icon in the Data List is changed to a crossed eye 
icon (see 230).

Illustration 230 
MultiAnalyzerNetworkViewer: Crossed Eye

4. To unhide one element, click again on the hidden element in the Data List.

5. To unhide all elements, click on the eye icon in the basic tools toolbar (see 231).

Illustration 231 MultiAnalyzerNetworkViewer: 
Eye Icon

✔ The elements are visible again (see 232).

Illustration 232 MultiAnalyzerNetworkViewer:  
Element Visible
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8.15 Activating GPS-Tracking

The MultiAnalyzerNetworkViewer has the opportunity to track GPS signalling.

To activate the GPS-Tracking, follow the next steps.

➔ A device for GPS-Tracking is available.

➔ The ‘Tracker Com Port’ and the ‘Tracker Baudrate’ are set in the settings (see chapter 8.2     Settings  ).

● To start the GPS-Tracking, select the checkbox ‘GPS Tracking’ in the toolbar (see 233).

Illustration 233 MultiAnalyzerNetworkViewer: GPS-Tracking

✔ GPS-Tracking is activated.

✔ The element ‘Centre on Own Position’ is available in the menu and in the toolbar (see 234).

Illustration 234 MultiAnalyzerNetworkViewer: Centre On Own Position

 The tracked position will be updated every 10th second.

 If the ‘Tracker Com Port’ and ‘Tracker Baudrate’ are set wrong in the setting window (see chapter 
8.2     Settings  ), the programme can not receive data for tracking the position.

 To deactivate the GPS Tracking, deselect the checkbox ‘GPS Tracking’.
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9 Glossary

A

AIE Air Interface Encryption
The Air Interface Encryption protects all 
signalling, identity and traffic across the radio 
link.

C

CCCH Common Control Channel
Common Control Channels are organisation 
channels in GSM networks. They are used to 
establish a communication connection.

D

DL Downlink
A radio transmission route between a sending 
base station and a receiving terminal.

DMO Direct Mode Operation
Communication between two or more radios 
without the usage of a base station and 
separated from the network. 

DMR Digital Mobile Radio
The Digital Mobile Radio is a European 
communication standard.

Dongle - A copy-protected hardware.

L

LAI Location Area Identity
This identifier is used to update the location of 
mobile subscribers.

M

MCCH Main Control Channel -

MS Multi Slot The bundling of several Time Slots (see TS).

N

NRD Network Recording Device
Network Recording Devices are supported 
devices that send IQ-data via network.
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P

P2P Peer-to-Peer

P2P is a communication model in which each 
party has the same capabilities. The P2P 
network allows every node to function as a 
client as well as a server.

P2MP Peer-to-Multipoint
P2MP is a communication network that 
provides a path from one location to multiple 
locations.

PDU Protocol Data Unit

Information that is delivered as a unit amongst 
coequal entities of a network. These 
information may contain control information, 
network address, or user data.

S

SDR Software Defined Radio
A broader term to sum up concepts of high-
frequency station and receiver where several 
parts are software realised.

SSI Short Subscriber Identity
Identification number to identify the mobile 
radios.

SwMI Switching and Management Infrastructure
The SwMI includes the base stations, switches 
and controllers. TETRA mobile registers and 
communicates with the SwMI.

T

TCH Traffic Channel
A mobile radio channel to transport data or 
voice.

TDMA Time Division Multiple Access
A provided time range for a station with full 
bandwidth.

TETRA Terrestrial Trunked Radio TETRA is a standard for digital trunked radio.

TMO Trunked Mode Operation

Communication between two or more radios 
via the network. The reach is not bounded to 
the operating place. All members can move 
within the network. 

TS Time Slot
A dedicated period within a transmission 
frame.
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U

UDP User Datagram Protocol UDP is a minimal message-oriented transport 
layer protocol.

UL Uplink A radio transmission route between a sending 
terminal and a receiving base station.
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